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Installation Instructions
This section provides the installation instructions for IT Business Analytics 10.00 Content Pack 0004.

Before you begin
Review all instructions and the Hewlett-Packard SupportLine User Guide or your Hewlett-Packard
support terms and conditions for precautions, scope of license, restrictions, and limitation of liability
and warranties, before installing this Content Pack.

Prerequisites
Before you install the Content Pack, perform the following steps:

1. Back up your customized files.

2. Back up your databases.

3. Ensure Java 7 is installed.

4. Make sure ITBA 10.00 is working, before starting the Content Pack installation.

5. Make sure all ETL and KPI calculation are not currently running.

Content Pack 0004 Installation Steps

Note: If you want to show Property in theShowback Detail for Cloud Services report, you
must install Cloud Service Automation (CSA) 4.50 and 4.50.0001 on the CSA server.

Install the Content Pack by performing the following steps:

Note: Each content pack includes the previous content packs.

1. In the ITBA server, backup the entire content pack located in $HPBA_Home/Content_Packs
directory.

2. Download the ITBA Content Pack 0004 (ITBA10_00_ContentPacks_0004.zip) from
(https://hpln.hpe.com/contentoffering/it-business-analytics-content-release ).
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3. Upload the installation file to the ITBA server and unzip it.

4. Upgrade the Content Packs:

a. In the ITBA server, backup the entire content pack folders located in the $HPBA_
HOME\ContentPacks directory.

b. Extract ContentPacks.zip from the root directory of the installation file.

c. UnzipContentPacks.zip, and use it to override the contents to the $HPBA_HOME directory.

d. Update the common jar file:

i. Get the commons-codec-1.4.jar file from the 3rd-jars directory in the installation file.

ii. Copy it to the $HPBA_Home/glassfish/glassfish/domains/BTOA/lib directory in the
ITBA server.

iii. Remove the following files from the ITBA server:

l $HPBA_HOME/glassfish/glassfish/domains/BTOA/lib/commons-codec-1.4-
14.0.6.1036.jar

l $HPBA_HOME/glassfish/glassfish/domains/BTOA/lib/commons-codec-1.3.jar

e. Restart ITBA by executing the following script in the ITBA server:

cd $HPBA_HOME/supervisor/bin

./hpba-restart.sh

f. Select ADMIN > Data Management >  Install Content Pack, select the relevant Content
Pack, and:

l If you had not already installed the Content Pack before installing the Content Pack 0004,
click Install.
After the installation completes, click Upgrade.

l If you had already installed the Content Pack before installing the Content Pack 0004,
click upgrade.

Note: If you had installed either one of the AWS or AWSCW Content Pack, youmust
upgrade both.

g. If you want to work with the latest CMS, install the Content Pack first and then import the
contexts (universes) using the following steps :

i. Unzip the content-pack-tool.zip located in the tools\dw-content-pack-tool directory in
the installation file.
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ii. Open content-pack-tool, and go to the bin directory.

iii. Execute the following command:

bash contentPackTool.sh -A

h. Execute SQL in Vertica by modifying the search path of the Vertica logon user:

ALTER USER [ITBA_VerticaUserName] search_path [ApplicationSchemaName] ,
[ExtensionSchemaName], "$user", public, v_catalog, v_monitor, v_internal;

The values of the parameters must be replaced with the correct values for your environment.

Example:

If the Vertica user is vertica, the password is openview, the ApplicationShemaName is
BA, and the ExensionSchemaName is ext, then the command to run on the appliance
VM is:

i. cd /opt/vertica/bin

ii. ./vsql –U vertica –d xsverticaPassword: openview

iii. ALTER USER vertica search_path BA , ext, "$user", public, v_catalog, v_
monitor, v_internal;

i. If necessay, clean the ETL data. For details, see "Clean ETL Data After Upgrade" on page 38.

j. Restart the BOE service.

Working with CMS and CAC
Towork with CMS and CAC:

1. Backup dw-web.war from the $HPBA_HOME/apps directory.

2. Replace dw-web.war in the $HPBA_HOME/apps directory with the provided hotfix dw-web.war.

3. Go to the $HPBA_HOME/bin directory, and run: ./deploy.sh –r dw-web.
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How to Upload .BIAR Files
SomeWebi reports are supported in ITBA. You can view these reports in the relevant ITBA Dashboard
pages.  They are provided in the CSA CAP and the CSA_DemoCAP.

You can view these reports through the Dashboard pages that are linked to the BOE server.

Only the CSA CAP reports are imported into the BOE server automatically if you have configured the
BOE connection while installing ITBA.

Note:

l Cloud_Billing.biar is needed for theBilling Statement for Cloud Services orBilling
Statement for Consumer Organization Admin reports provided in the CSA CAP.

l Cloud_Billing_Demo.biar is needed for theBilling Statement for Cloud Services Demo
report provided by the CSA_DemoCAP.

If you did not configure the BOE connection while installing ITBA, or if you want to watch demo reports,
run the below steps.

To import theCloud_Billing.biar or theCloud_Billing_Demo.biar:

1. Copy the .biar files from the ITBA server:

$HPBA_HOME /ContentPacks/CSA/INBUILT/BI/BOE/Cloud_Billing.biar

$HPBA_HOME /ContentPacks/DEMO_CONTENT/INBUILT/BI/BOE/Cloud_Billing_
Demo.biar

2. Log on to the SAP BusinessObjects Central Management Console (CMC) at: http://<BOE_
Server_IP>:8080/BOE/CMC.
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3. Click Promotion Management.

4. Click Promotion Jobs > Import > Import file.

5. Click Choose File and select the relevant .biar file.
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6. In theDestination field, select Login to a New CMS.

7. Enter the BOE server IP number or server name, user name, and password, and then click Login.

8. Click Create to create promotion job.
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9. Click Promote.

10. Click Promote.

The .biar file is uploaded successfully.
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11. Log on to theUniverse Design Tool from the BOE Client.

12. Click Tools > Connections…. Edit the relevant connection.

If you are uploading the CSA CAP, edit XS_DWH_JDBC.

If you are uploading the CSA_DemoCAP, edit XS_EXT_JDBC.
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13. Enter the relevant connectionmessage of the Vertica server and click Next.

14. Click Next > Finish > Close.

The import of the .biar files is complete.

15. By default, the application schema name is BA, the extension schema name is ext, and the
database name is xsvertica. If the customer server settings are different, change the as shown
below.
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a. Click File > Import…, and select theCloud Billing universe directory.

b. Select Cloud Billing and click OK.
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c. Right-click the relevant table, and select Rename Table.

d. In theOwner field enter the correct application schema name and in theQualifier field enter
the correct database name.

e. After modifying all the relevant tables as shown above, click File > Export….
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f. Click OK to upload the changes to BOE the server.

16. Proceed in the sameway for the Cloud Billing Demo universe directory.
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Limitations

Formula Filter Including '('
If the parameters in a KPI/Metric formula filter Expression contain ‘ (’, the space is removed during the
formatting of the formula and the calculation will be incorrect.

Example:

l Original formula:
PERCENTAGE( ASSET , ASSET.ASSET_STATUS Like 'Return for maintenance%' And
ASSET.DATE_INSTALLED <= END_PERIOD , ASSET.ASSET_STATUS <> 'Retired
(demo)' And ASSET.ASSET_STATUS <> 'unknown' And ASSET.DATE_INSTALLED <=
END_PERIOD

l Formatted formula:
PERCENTAGE( ASSET , ASSET.ASSET_STATUS Like 'Return for maintenance%' And
ASSET.DATE_INSTALLED <= END_PERIOD , ASSET.ASSET_STATUS <> 'Retired
(demo)' And ASSET.ASSET_STATUS <> 'unknown' And ASSET.DATE_INSTALLED <=
END_PERIOD

Workaround: Separate the string with '||'.

Example:

l Original formula:
PERCENTAGE( ASSET , ASSET.ASSET_STATUS Like 'Return for maintenance%' And
ASSET.DATE_INSTALLED <= END_PERIOD , ASSET.ASSET_STATUS <> 'Retired
(demo)' And ASSET.ASSET_STATUS <> 'unknown' And ASSET.DATE_INSTALLED <=
END_PERIOD

l should be replaced:
PERCENTAGE( ASSET , ASSET.ASSET_STATUS Like 'Return for maintenance%' And
ASSET.DATE_INSTALLED <= END_PERIOD , ASSET.ASSET_STATUS <> 'Retired '||'
(demo)' And ASSET.ASSET_STATUS <> 'unknown' And ASSET.DATE_INSTALLED <=
END_PERIOD
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KPI Breakdown Formula Limitation
When you configure the formula of a KPI for which you will set up Breakdowns, make sure that you do
not usemultiple entities.

Example of a correct formula, the formula uses the same entity for the numerator and
denominator

PERCENTAGE_MATH(SUM(CostAmount,CostExpenseType = 'CAPEX' and PERIOD_
ENTITY=Period),SUM(CostAmount,CostExpenseType = 'OPEX' and PERIOD_
ENTITY=Period),100)

Example of an incorrect formula; the formula uses two different entities for the numerator and
denominator and that might cause the Breakdown calculations to be incorrect.

PERCENTAGE_MATH(SUM(CostAmount,CostExpenseType = 'CAPEX' and PERIOD_
ENTITY=Period),SUM(Cost,CostExpenseType = 'OPEX' and PERIOD_ENTITY=Period),100)

The connection to the data source fails after timeout when
connecting to the CMS CAC environment
To fix the issue, download and install the following hotfix:

https://patch-central.corp.hp.com/crypt-web/protected/viewContent.do?patchId=EXSC_00220
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CP0004 Enhancements and Their Documentation
This section provides the changes and additions to the documentation that support Content Pack 0004.

Enhancements

The enhancements provided by CP0004 are:

l The new CMS andCMS_demoCAPs. For details, see "CMS_Demo and CMS Content
Acceleration Packs" on the next page.

l A new CMS Content Pack. For details, see "Integration with CMS" on page 32.

l Support for CMS 10.1 and 10.2

l Support for CSA 4.6

l Support for ALM 12.2, and 12.5

l The update of an SA KPI name

l A hotfix for CMS CAC. For details, see "Working with CMS and CAC" on page 6.

l A KPI limitation

l Clean ETL Data after upgrade to CP0004. For details, see "Clean ETL Data After Upgrade" on page
38.

Documentation

The pages that follow describe the enhancements listed above and replace the relevant pages or do not
appear in the ITBA 10.00 documentation.
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CMS_Demo and CMS Content Acceleration Packs

The purpose of the CMS Content Acceleration Pack (CAP) is to provide a set of items (Dashboard
pages, Scorecards, Contexts, KPIs, Metrics, andmore) that automatically gathers information from
across your enterprise to build key performance indicators (KPIs) related to CMS-related issues with
OOTB data from DataWarehouse. The CAP includes the CMS Governance, Cloud and Virtualization
Perspectives. The CAP provides broad and deep insight that should enable you to Improve CMS
Accuracy, Improve CMS Completeness, Improve CMS Modeling Completeness, Improve
Virtualization Utility. This CAP provides a 360 degree view.

To access:

Click Admin > Data Management > Activate CAP. You can then select the relevant CAP and
activate it.

If the CAP you want to activate is not the demoCAP, youmust make sure you have installed the
relevant Content Pack, connected the relevant data source, optionally configured the consolidations,
and run the ETL to see the relevant data in the CAP Dashboard pages.

Learn More

What are Content Acceleration Packs (CAPs)

Content Acceleration Packs (CAPs) are packages that include Dashboard pages that display
Scorecards and components, KPIs, Metrics, Contexts (universes), data (from .CSV files or from data
sources), and documentation for the CAP. You can import them, export them, activate, or deactivate
them, or you can create your own.

CAPs describe typical stories that show how the correct implementation of Business Analytics drives
Performance Improvement and Cost Reduction for the IT organization.

CAPs demonstrate Business Analytics capabilities, and helps you add basic elements that can be
used to customize your Dashboard.

The CMS_Demo is based on data in .csv files that are part of the CAP package and CMS CAPs
include data from the UCMDB data source.
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Pages

IT Configuration Manager (CMS and AM)(Demo)

IT Configuration Manager (CMS and AM)
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IT Configuration Manager (CMS)(Demo)

IT Configuration Manager (CMS)

Tasks

This section includes:

Upload and manage the Content Acceleration Pack

For details, see Content Acceleration Packs (CAPs).
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View the CMS or CMS_Demo CAP-related Dashboard page

1. In the ITBA application, close all the tabs. The Dashboard is displayed.

2. Select one of the relevant pages inSelect Page or click thePage Gallery button in the

Dashboard toolbar, double-click the relevant icon and close the PageGallery dialog box.

View the Scorecard Structure and KPI and Metric Breakdowns in the Studio

1. Make sure the CAP is activated.

2. In the Business Analytics application, click Studio.

3. Expand the relevant Scorecards to view the Scorecards, Perspectives, Objectives, KPIs,
KPI Breakdowns structure.

User Story

1. Maggie is the IT ConfigurationManager at ABC Inc. Shemanages the configurationmanagement
system in the IT organization.

One of her responsibilities is to ensure that all assets are accurately defined and identified in the
configurationmanagement system in support of business needs.

2. She logs into the ITBA application and opens the IT Configuration Management (CMS) page in
Dashboard.

3. She first looks at the Improve CMS CompletenessObjective.

4. Then she clicks the Objective and finds that theCIs Synced Between CMS and AM vs CIs in
AM KPI is red.

5. In the Historical View in the sameDashboard page, she finds that the KPI value decreased
considerably during the past week.

6. To understand why the KPI is red, Maggie clicks on the KPI to open EXPLORER, where the pie
clearly shows there are still lots of missing CIs when compared to the CIs in the Asset Manager.

7. Maggie sends an annotation to Richard, the Discovery Administrator requesting clarifications:
"Richard –We have poor CMS Completeness, please provide insight and set a plan by EOW".

8. Richard is responsible for collecting, discovering, andmaintaining the configuration information for
hardware assets in the configurationmanagement system. After he receives the annotation from
Maggie, he checks his report and starts the analysis of the problem.
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9. Richard then replies toMaggie that he will initiate ameeting with the Discovery Team to discuss
the issue.

10. ThenMaggie looks at the Improve CMS AccuracyObjective.

11. She clicks the Objective and finds that thePercentage of Authorized CIsKPI is red

12. To understand why the KPI is red, Maggie performs a Breakdown on this KPI by CI Type. She
finds out that Network Component only hits 20% of authorized CIs and is the cause of the red
ratio of the KPI.

13. She clicks on theNetwork Component in the legend to open the KPI EXPLORER, where the
data shows details for whichNetwork ComponentCIs are not authorized.

14. Maggie sends an annotation to John, the Configuration Team Leader: "John –We have poor CMS
accuracy on Network Component CIs. Please provide insight and set a plan by EOW".

The Configuration Team and John are responsible for authorizing the configuration item in the
configurationmanagement system.

15. When John gets the annotation fromMaggie, he checks his report and starts the analysis of the
problem.

16. John then replies toMaggie that he will work with the team to address the issue by EOW.

17. Then, Maggie updates the server virtualization results to her manager Steve, who is the director of
the IT Organization, to helpmoving their traditional IT to the new style of IT in order to optimize the
running of their IT organization.

18. She looks at the Improve Virtualization UtilityObjective.

19. She clicks the Objective and finds that thePercentage of Server Virtualization KPI is red

20. To understand why the KPI is red, Maggie looks at theServer by Virtualization pie chart. She
sees that only 30% of servers are running on the cloud and virtualization technology.

21. Maggie sends an annotation to Steve: "Steve –We have poor performance on server
virtualization, I will setup ameeting with the IT infrastructure team to push themmovemore
servers on the cloud".
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UI Description

CMS_Demo and CMS

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):
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UI Element Description

Pages See "Pages " on page 24.

Scorecards l IT ConfigurationManager (CMS and AM)

l IT ConfigurationManager (CMS)

Business
Contexts

CMS_ConfigurationManagementSystem

For details, see Reference: Contexts (Universes) in theContent ReferenceGuide.

KPIs and
Metrics Note: The DemoCAP includes KPIs with names followed by (Demo). The

CAP includes the same KPIs with names that do not include (Demo). The KPIs
are the same but have different names so that both the DemoCAP and the CAP
can be activated at the same time.

Applications Synced Between UCMDB and AM vs Applications in AM KPI

The number of Business Applications synchronized between CMS and AM compared
to the number of Business Applications in AM.

CIs Synced Between CMS and AM vs CIs in AM KPI

The number of CIs synchronized between CMS and AM compared to the number of
CIs AM (for CIs of type Node, Business Service, Infrastructure Service, or Business
Application).

Nodes Synced Between CMS and AM vs Nodes in AM KPI

The number of Nodes synchronized between CMS and AM compared to the number
of Nodes in AM.

Percentage of Application Virtualization KPI

The number of Business Applications provided by the relative Server components
running on cloud virtualization technology relative to the total number of Business
Applications (KPIs show data only if you are using CMS 10.22 and above).

Percentage of Applications Related to Nodes KPI

The number of Business Applications that have at least 1 direct or indirect relationship
with a Node relative to the number of Business Applications.

Percentage of Authorized Applications KPI

The number of authorized Business Applications relative to the total number of
Business Applications (KPIs show data only if you are using UCMDB Configuration
Manager).

Percentage of Authorized CIs KPI

The number of authorized CIs relative to the total number of CIs (KPIs show data only
if you are using UCMDB ConfigurationManager).

Percentage of Authorized Nodes KPI
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UI Element Description

The number of authorized Nodes relative to the total number of Nodes (KPIs show
data only if you are using UCMDB ConfigurationManager).

Percentage of Authorized Services KPI

The number of authorized Services relative to the total number of Services (Service in
Business Service or Infrastructure Service) (KPIs show data only if you are using
UCMDB ConfigurationManager).

Percentage of Node Virtualization KPI

The number of Nodes that are running on cloud virtualization technology relative to the
total number of Nodes (KPIs show data only if you are using CMS 10.22 and above).

Percentage of Nodes with Vendors KPI

The number of Nodes that contain vendor information relative to the total number of
Nodes.

Percentage of Service Virtualization KPI

The number of Services provided by the relative Server components running on cloud
virtualization technology relative to the total number of Services (Service in Business
Service or Infrastructure Service) (KPIs show data only if you are using CMS 10.22
and above).

Percentage of Services Modeled by Automated Service Modeling KPI

The number of Services that aremodeled by automated servicemodeling relative to
the number of Services that are created during themeasurement period (Service in
Business Service and Infrastructure Service) (KPIs show data only if you are using
CMS 10.2 and above).

Percentage of Services Related to Nodes KPI

The number of services that have at least 1 direct or indirect relationship with a Node
relative to the number of services (Service in Business Service or Infrastructure
Service).

Services Synced Between CMS and AM vs Services in AM KPI

The number of Services synchronized between CMS and AM compared to the number
of Services in AM (Service in Business Service or Infrastructure Service).

CMS Growth Metric

The number of CIs created in the last period relative to the number of CIs created in
the previous period.

Number of CIs Monitored by CMS Metric

The total number of CIs monitored by CMS.

Number of CIs Not in Authorized State Metric
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UI Element Description

The total number of CIs that are not in authorized state.

Number of Missed CIs Compared to Asset Manager Metric

The number of CIs in Asset Manager that do not have a relevant CI record in CMS (for
CIs of type Node, Business Service, Infrastructure Service, or Business Application).

Number of Nodes Monitored by CMS Metric

The total number of Nodes Monitored by CMS.

Data
(External
Tables)

CMS_demo
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Integration with CMS

HPE ConfigurationManagement System (CMS) comprises three components: UCMDB, Discovery,
and ConfigurationManager. The UCMDB reconciles data frommultiple discovered and federated
sources into one data set, model your business services, calculate the potential impact of changes
within these services, track changes for any configuration item, and contains reporting capabilities to
transform CMDB data into comprehensible, actionable information that helps answer critical questions
and solve business problems. HPE Universal Discovery (UD) software is used by UCMDB to acquire
andmaintain application and IT infrastructure data. ConfigurationManager makes it possible to analyze
IT environments in order to move toward fewer standards and improve IT management processes. This
helps you improve data quality in your configurationmanagement system (CMS), avoid single points of
failure, achieve geographic redundancy of applications and drive changes based on configuration
standards.

This section describes the integration, contexts, KPIs, Metrics, and reports, if any, associated with the
integration with the ConfigurationManagement System data source.

The purpose of the integration of ConfigurationManagement System (CMS) as a data source is to bring
quality management information into the DataWarehouse.

To access:

Select ADMIN > Data Management > Connect Data Source then click Add data source and select
CMS to activate the integration processes for theCMS data source.

Learn More

Content Packs and their functionality

To learn about Content Packs and their functionality see, Connect the Data Source in theAdministrator
Guide.

DCS Integration:

An extractor using the Data Collection Servicemechanism that extracts entities from the CMS source
and generates corresponding flat files using the TQL query language. For details, see Connect the Data
Source in theAdministrator Guide.
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Important Information

l CMS supports multiple instances of the Content Pack.

l All fields are case-sensitive.

Tasks

Activate the integration

1. Activate the CMS Data Source:

a. Select ADMIN > Data Management > Connect Data Source then click Add data source.

b. The Add Data Source page opens. Select theCMS data source type.

c. Select or enter the configuration parameters.

d. Click Next to proceed to the validation page.

Note: The system does not support changing theData Source Type, therefore youmust
select the relevant type: CAC or non-CAC, before activation.

Note: Before reactivating the CMS data source, click Edit Settings and enter theUsername
andPassword.

Connect to CMS on a Secured Connection

1. Export the CMS SSL certificate to a file. For details, see the CMS Hardening Guide available in
the HPE Software Support Online web site
(https://softwaresupport.hp.com/group/softwaresupport/home).

2. If you have selected CAC, perform this step, otherwise go to the next step.

To reveal the CMS certificate to DataWarehouse, import the SSL certificate trusted by the CMS
server into the JDK key store using a tool provided by the JDK called keytool.exe by running the
command :

$HPBA_Home/dk/jre/bin/keytool -importcert -alias <alias> -file <file> -keystore
%HPBA_Home%/jdk/jre/lib/security\cacerts -trustcacerts
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Note: The default password for JVM keystore is a 'changeit'. If this password wasn't
changed before, use the default keystore password for certificate import.

3. Restart the ITBA server.

4. Select Is secured in the activation parameters page.

Is secured unchecked with NON CAC still works.

5. Change the port to a secured port. Default port is 8080. Secured default port is 8443, CAC default
port is 8444.

UI Description

CMS Activation Page

The data warehouse is connected to ConfigurationManagement System through high-level integration
processes.
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l Non CAC Access:

Mandatory fields aremarked with a red asterisk.

l CAC Access:

Content Pack 0004 for BA 10.00
Documentation_Additions

HPE IT Business Analytics (10.00)
Monday, March 28, 2016- 7:07:55 AM Page 35 of 182



UI Element Description

Instance name Enter a name for the data source instance you are activating.

CMS Version Select the relevant CMS version. For details, see theSupport Matrix.

Time Zone Select the time zone for the data source.

Data Source Type CMS.

Access Type Select CAC orNon CAC

Certificate/User
Name

If you select CAC, the field is displayed as Certificate. Enter the name of
the certificate.
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UI Element Description

If you select Non CAC, the field displayed as User Name. Enter the name
of the user used to access the UCMDB server.

Password If you select CAC, enter the password of the UCMDB server's certificate
file.
If you select Non CAC, enter the password of the user used to access the
UCMDB server.

Is Secured Select to use https to get data.

Unselect to use http to get data.

Hostname/IP
Address

Enter the CMS hostname or IP address.

Port Enter the server port number.

Customer Name Used for multi-customer purposes. If no user name is given, thenDefault
Client is displayed.

Initial Load Period
(months)

Select the number of months from which you want the initial data loaded.

Reference

CMS-Related KPIs andMetrics

For a list of the CMS-related KPIs andMetrics, see KPIs andMetrics in theContent Acceleration
Packs Guide.
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Clean ETL Data After Upgrade

This section describes the cases when you need to clean the existing ETL data for the relevant Content
Pack after upgrading from specific versions of Content Packs (CP) to CP0004.

To clean the ETL data, see Clean the ETL data in theUtility Tools Guide.

To download the Utility Tool Guide, go to HPLN (https://hpln.hp.com/group/it-business-analytics, click
Resources >  5.Tools > ITBA 10.0, and download the PDF.

To check if you need to clean the ETL data, see the conditions below:

Integration with Base Version Target Version
Clean the existing
ETL data

CSA 10.00 10.00 CP0004 Yes

10.00 CP0001

10.00 CP0002

10.00 CP0003

10.00 CP0004 No

AWS/AWSCW 10.00

10.00 CP0001

10.00 CP0004 Yes

10.00 CP0002

10.00 CP0003

10.00 CP0004 No

AM 10.00 CP0003 10.00 CP0004 Yes if you want to
use the KPI across
CMS and AM

10.00 CP0001

10.00 CP0002

10.00 CP0004 No
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CP0003 Enhancements and Their Documentation
This section provides the changes and additions to the documentation that support Content Pack 0003.

Enhancements

CP0003 helps you obtain Asset Manager business data including Asset Lifecycle, Procurement,
Finance, Vendor Contract and software license information. It provides:

l Integration with AM. The collected data is integrated into AM-related KPIs, Metrics, and Dashboard
pages. For details, see "Integration with AM" on the next page and "AM_Demo and AM Content
Acceleration Packs" on page 46.

l Support for Asset Manager 9.41 and 9.50.

l Support for MSSQL andOracle.

l Integration with vPV. The collected data is integrated into CSA-related KPIs, Metrics, and
Dashboard pages.

l New AM KPIs.

Documentation

The pages that follow describe the enhancements listed above and replace the relevant pages or do not
appear in the ITBA 10.00 documentation.
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Integration with AM

Asset Management helps you tomanage your assets across procurement, active lifecycle, and
disposals so you can optimize end-to-end asset usage for optimal value and lower costs.

The AM integration uses the SAP BusinessObjects Data Services drivers for data store connections.

This section describes the integration, contexts, KPIs, Metrics, and reports, if any, associated with the
integration with the Asset Manager data source.

The Asset Manager (AM) content pack enables you to receive data information from the
AM application. AM is a fully integrated suite of modules delivered as part of the ServiceManagement
Center software package. AM softwaremanages the physical, virtual, financial, and contractual
aspects of assets.

Note: Information about the ALT data source andmore general content issues are detailed in the
Content ReferenceGuide.

To access:

Select ADMIN > Data Management > Connect Data Source then click Add data source and select
AM to activate the integration processes for theAM data source.

Learn More

Content Packs and their functionality

To learn about Content Packs and their functionality see, Connect the Data Source in theAdministrator
Guide.

Important Information

l The AM Content Pack supports multiple instances.

l DCS Integration: An extractor using the Data Collection Servicemechanism that extracts entities
from the source and generates corresponding flat files. For details, see Data Collection Service
(DCS) in theAdministrator Guide.
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l All fields are case-sensitive.

Tasks

Activate the integration

1. Prerequisite:

The AM data source can have either the Oracle or the SQL Server type.

2. Activate the AM Data Source:

a. Select ADMIN > Data Management > Connect Data Source then click Add data source.

b. The Add Data Source page opens. Select theAM data source type.

c. Select or enter the configuration parameters.

d. Click Next to proceed to the validation page.

Note: The system does not support changing theData Source Type, therefore youmust
select the relevant type, SQL or Oracle, before activation.

UI Description

AM Activation Page

The data warehouse is connected to Asset Manager through high-level integration processes.

User interface elements are described below:
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For the SQL server:

The following is an example of the AM Activation page when the database backup of Asset Manager is
restored on an SQL Server.

Mandatory fields aremarked with a red asterisk.

UI Element Description

Instance name Enter a name for the data source instance you are activating.

AM Version Select the relevant AM version. For details, see theSupport Matrix.

Time Zone Select the time zone for the data source.
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UI Element Description

Data Source Type AM should be configured to run on an SQL Server.

Username Enter the username used to log on to the AM database.

Password Enter the password used to log on to the AM database.

Hostname/IP Address Enter the SQL server database hostname or IP address.

Port Enter the server port number.

Database Name Enter the database name used by AM.

Initial Load Period
(months)

Select the number of months from which you want the initial data
loaded.

Content Pack 0004 for BA 10.00
Documentation_Additions

HPE IT Business Analytics (10.00)
Monday, March 28, 2016- 7:07:56 AM Page 43 of 182



For the Oracle Server:

The following is an example of the AM Activation page when the database backup of Asset Manager is
restored on anOracle Server.

Mandatory fields aremarked with a red asterisk.

Note: TheOracle database can have both Server ID (SID) and Service Name properties, but the
user should specify only one. If you define the SID, then the SID is used, and if you define Service
Name, then Service Name is used. If you define both in the UI, only SID is used.
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UI Element Description

Instance name Enter a name for the data source instance you are activating.

AM Version Select the relevant AM version. For details, see theSupport Matrix.

Time Zone Select the time zone for the data source.

Data Source Type AM should be configured to run on anOracle server.

Username Enter your username used to log on to the AM database.

Password Enter your password used to log on to the AM database.

Hostname/IP
Address

Enter the Oracle server hostname or IP address.

Port Enter the server port number.

SID Enter the unique name of the database.

Service Name Enter the alias used when connecting.

Initial Load Period
(months)

Select the number of months from which you want the initial data loaded.

Reference

AM-Related KPIs andMetrics

For a list of the AM-related KPIs andMetrics, see KPIs andMetrics in theContent Acceleration Packs
Guide.
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AM_Demo and AM Content Acceleration Packs

The purpose of the AM_Demo and AM Content Acceleration Packs (CAPs) is to provide a set of items
(Scorecards, Contexts, KPIs, Metrics, andmore) that automatically gathers information from across
your enterprise to build key performance indicators (KPIs) related to AM-related issues with OOTB data
from DataWarehouse as well as Dashboard pages that display the relevant information. The CAPs
provide broad and deep insight that should enable you to Improve Staff Effectiveness, Improve
Responsiveness, Achieve Process Excellence, ImproveQuality of Delivery, and Improve Customer
Satisfaction. This CAP provides a 360 degree Asset Manager view.

To access:

Click Admin > Data Management > Activate CAP. You can then select the relevant CAP and
activate it.

If the CAP you want to activate is not the demoCAP, youmust make sure you have installed the
relevant Content Pack, connected the relevant data source, optionally configured the consolidations,
and run the ETL to see the relevant data in the CAP Dashboard pages.

Learn More

What are Content Acceleration Packs (CAPs)

Content Acceleration Packs (CAPs) are packages that include Dashboard pages that display
Scorecards and components, KPIs, Metrics, Contexts (universes), data (from .CSV files or from data
sources), and documentation for the CAP. You can import them, export them, activate, or deactivate
them, or you can create your own.

CAPs describe typical stories that show how the correct implementation of Business Analytics drives
Performance Improvement and Cost Reduction for the IT organization.

CAPs demonstrate Business Analytics capabilities, and helps you add basic elements that can be
used to customize your Dashboard.

The AM_Demo is based on data in .csv files that are part of the CAP package and AM CAPs include
data from the Asset Manager data source.
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Pages

AM - Director of IT Asset Management Page

Tasks

This section includes:

Upload and manage the Content Acceleration Pack

For details, see Content Acceleration Packs (CAPs).

View the AM or AM_Demo CAP-related Dashboard page

1. In the ITBA application, close all the tabs. The Dashboard is displayed.

2. Click theAM - Director of IT Asset Management tab. If it is not displayed, select it inSelect

Page or click thePage Gallery button in the Dashboard toolbar, double-click the relevant icon

and close the PageGallery dialog box.
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View the Scorecard Structure and KPI and Metric Breakdowns in the Studio

1. Make sure the CAP is activated.

2. In the Business Analytics application, click Studio.

3. Expand the relevant Scorecards to view the Scorecards, Perspectives, Objectives, KPIs,
KPI Breakdowns structure.

User Story

1. Maggie is the IT Director of Asset Management at ABC Inc. Shemanages the entire asset life-
cycle of the IT organization.

2. One of her responsibilities is to ensure that the software licenses are compliant.

3. She logs into the AM –Director of IT Asset Management Dashboard page, and looks at her
Scorecard to understand the overall performance of her organization and finds that the Increase
Compliance Objective under theSoftware LicensePerspective is red.

4. She clicks the Objective and finds that the cause is theSoftware Compliance Ratio KPI that is
also red.

5. Meanwhile, the Historical View shows, for theSoftware License ComplianceKPI , a negative
weekly trend for the last two weeks. Based on the current results, the Forecast component also
shows a continuously decline for the week after and in the future.

6. Drilling down further, Maggie then looks at the KPI Breakdown calledSoftware License
Compliance Ratio Breakdown by Supplier in the Pie Chart View and realizes that theDell
Computer supplier only meets less than 45 percent of the license compliance ratio and is the
cause of the red ratio of the KPI. She then clicks on theDell Computer legend to open the KPI
EXPLORER, where the data shows details about the software count for which licenses are not
compliant.

7. Maggie sends an annotation to Richard, the Supplier Manager, requesting clarifications:"Richard –
We have poor Software License Compliance performance on “ApacheGroup” supplier, please
provide insight and set a plan by EOW".

8. Richard is responsible for maintaining the license contracts with the ApacheGroup supplier. When
he gets the annotation fromMaggie he checks his Scorecard and starts the analysis of the
problem.

9. Richard then replies toMaggie that he will initiate ameeting with the supplier to discuss the
license contract.
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UI Description

AM_Demo and AM

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Pages See "Pages " on page 47.

Scorecards l Asset Manager (Demo)

l Asset Manager

Business
Contexts

l AM_Demo

l Asset_Management

For details, see Reference: Contexts (Universes) in theContent ReferenceGuide.

KPIs and
Metrics Note: The DemoCAP includes KPIs with names followed by (Demo). The

CAP includes the same KPIs with names that do not include (Demo). The KPIs
are the same but have different names so that both the DemoCAP and the CAP
can be activated at the same time.

l Average Age of Hardware Assets KPI

The average age of hardware assets.
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UI Element Description

l Average Time to Procure Hardware KPI

The average time needed to procure an item defined as the time lag between a
request for procurement and the contract signing or the purchase.

l Delivery On-Time Ratio KPI

The ratio is calculated as the number of receipt lines for which the delivery is on-
time divided by the total number of receipt lines.

l Number of At Risk Software Applications KPI

The number of software applications for which the license count exceeds the
license pool.

l Number of Contracts to Expire Soon KPI

The number of Contracts that will expire in the coming threemonths.

l Number of Overspending Budget Centers KPI

The number of budget centers that ran over budget during the last fiscal year, in
terms of gap between actual spending vs. budget.

l Number of Overspending Software Applications KPI

The number of software applications for which the license count is lower than than
the license pool.

l Number of Unscanned Nodes KPI

The number of nodes that have not being scanned for more than 3months.

l Number of Unused Software Applications KPI

The number of software applications that were unused for more than threemonths.

l Percentage of Assets Returned to Supplier KPI

The number of assets returned to the suppliers relative to the total number of
assets.

l Percentage of Assets in Maintenance KPI

The number of assets in maintenance relative to the total number of assets.

l Percentage of Changes in Assets Cost KPI

The asset cost in the last period relative to the asset cost in the previous period.

l Return Ratio KPI

The ratio is calculated as the total quantity of returned assets divided by the total
quantity of received assets.

l Software License Compliance Ratio KPI

The number of software applications where the license count are lower than the
license pool divided by the number of software counters.
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UI Element Description

l Total Budget vs. Total Cost KPI

The total budget vs the total cost in the last fiscal year.

l Work Order Resolution On-Time Ratio KPI

The ratio is calculated as the number of on-time work orders divided by the total
number of work orders.

l Total Cost of Asset KPI

The total cost of assets during themeasurement period. Supports Breakdown by
Cost Center or Asset Type.

l Total Cost of Cost Centers

The total cost of cost centers during themeasurement period. Supports
Breakdown by Cost Center.

Data
(External
Tables)

AM_demo
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CP0002 Enhancements and Their Documentation
This section provides the changes and additions to the documentation that support Content Pack 0002.

Enhancements

The IT Business Analytics 10.00 Content Pack 0002 release provides:

l An updated and enhanced cloud integration that includes:

o The new Azure Content Pack to obtain Microsoft Azure public cloud data including Azure billing,
resource consumption, and VM resource utilization information. For details, see "Integration with
Azure" on page 57.

o The new Virtual Performance View (vPV) Content Pack to obtain:

l VMware VCenter private cloud data including VM cost and consumption, VM utilization, and
VM allocation information.

l Helion OpenStack Version 2.0 private cloud data including VM cost and consumption, VM
utilization, and VM allocation information.

For details, see "Integration with vPV" on page 165.

o An enhanced CSA Content Pack that provides the new Resource Usage and Utilization for
Consumer andResource Usage and Utilization for Resource Supply Manager reports. For
details, see "CSA_Demo and CSA Content Acceleration Packs" on page 133

o An enhanced AmazonWeb Services (AWS) Content Pack that provides the new Amazon EC2
Instance Usage and Utilization report. For details, see

l The new Server Automation (SA) Content Pack to obtain Server Automation data including Node,
Job, Policy, and Compliance information. The Content Pack also includes new SA KPIs. For
details, see "CSA_Demo and CSA Content Acceleration Packs" on page 133.

Documentation

The pages that follow describe the enhancements listed above and replace the relevant pages or do not
appear in in the ITBA 10.00 documentation.
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Integration with AWS

This section describes the integration, contexts, KPIs, Metrics, and reports, if any, associated with the
integration with the AmazonWeb Services data source.

AmazonWeb Services (AWS) offers a complete set of infrastructure and application services that
enable you to run virtually everything in the cloud: from enterprise applications and big data projects to
social games andmobile apps. One of the key benefits of cloud computing is the opportunity to replace
up-front capital infrastructure expenses with low variable costs that scale with your business.

The purpose of the integration of AWS as a data source is to bring AWS information into the Data
Warehouse.

To access:

Select ADMIN > Data Management > Connect Data Source then click Add data source and select
AWS to activate the integration processes for theAWS data source.

Learn More

Cloud Optimization Offering

The CloudOptimization offering includes integrations with:

l Amazon Web Services (AWS). For details see Integration with AWS in theContent Reference
Guide.

l Amazon Web Service CloudWatch(AWSCW). For details see Integration with AWSCW in the
Content ReferenceGuide.

l Cloud Service Automation (CSA). For details see Integration with CSA in theContent Reference
Guide.

Content Packs and their functionality

To learn about Content Packs and their functionality, see Connect the Data Source in theAdministrator
Guide.
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Important Information

l The AWS Content Pack supports multiple instances.

l DCS Integration: An extractor using the Data Collection Servicemechanism that extracts entities
from the source and generates corresponding flat files. For details, see Data Collection Service
(DCS) in theAdministrator Guide.

l All fields are case-sensitive.

l The AWS DCS extraction of the csv file from the S3 bucket uses a properties file along with the
datasource.xml file. It is available once the AWS content pack is deployed under: $HPBA_
Home/ContentPacks/AWS/conf.

The properties file defines fixed csv properties, such as the csv file name, suffix, time format, filters
in csv file, delayDay, and can bemodified.

l AWS proxy parameters are optional in a public network.

l

Tip: If you integrate with both CSA and AWS/AWSCW, youmust run the AWS/AWSCW ETL
before the CSA ETL. If you do not run the ETL as recommended, youmust wait for the end of
the CSA ETL run to view the correct data.

l The cloud-related reports (Dashboard pages) provided in the CSA_CAP and CSA_Demo_
CAP CAPs combine integrated data from the following data sources Cloud Service Automation
(CSA), AmazonWeb Services (AWS), AmazonWeb Service CloudWatch (AWSCW)

For details, see CSA_Demo and CSA Content Acceleration Packs in theContent Acceleration
Packs Guide.

Tasks

Activate the Integration

1. Select ADMIN > Data Management > Install Content Pack then click the install button
relevant for the data source.

2. Select ADMIN > Data Management > Connect Data Source then click Add data source.

3. The Add Data Source page opens. Select theAWS data source type.

4. Select or enter the configuration parameters.
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5. Click Next to proceed to the validation page.

UI Description

AWS Activation Page

The following is an example of the AWS Activation page.
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User interface elements are described below:

Note: If the AWS configuration is for a named instance connection, make sure to enter the named
instance port.

UI Element Description

Instance name Enter a name for the data source instance you are activating.

AWS Version This parameter is Not Applicable.

Time Zone PST only

Data Source Type AWS. This parameter is read only.

Access Key Id Enter the AWS access key ID.

Secret Access Key Enter the AWS secret access key.

Bucket Enter the AWS S3 bucket namewhich was specified when you set up the
Programmatic Billing Access.

Account Id Enter the AWS account ID.

Proxy Host Enter the proxy host name.

Proxy Port Enter the proxy port number.

Proxy Username Enter the proxy username used to log on to the network.

Proxy Password Enter the proxy password used to log on to the network.

Proxy Domain Enter the proxy domain.

Proxy Workstation Enter the proxy workstation.

Initial Load Period
(months)

Select the number of months from which you want the initial data loaded.

Reference

AWS-Related KPIs and Metrics

The KPIs andMetrics related to the AmazonWeb Services data source are provided in the CSA and
CSA_DemoCAPs. For details, see CSA_Demo and CSA Content Acceleration Packs in theContent
Acceleration Packs Guide.
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Integration with Azure

Azure is Microsoft cloud computing platform, a growing collection of integrated services like analytics,
computing, database, mobile, networking, storage, and web, for moving faster, achievingmore, and
savingmoney.

The purpose of the integration of Azure as a data source is to bring Azure information into the Data
Warehouse.

The integration with Azure provides a general idea on how muchmoney is spent on each Virtual
Machine daily by different usage types. In addition, if the diagnostics function is enabled, you can also
view the CPU utilization andMemory.

The data extracted from Azure is correlated to the data available in the KPIs and reports available in the
CSA CAP. For details, see CSA_Demo and CSA Content Acceleration Packs in theContent
Acceleration Packs Guide.

To access:

Select ADMIN > Data Management > Connect Data Source then click Add data source and select
Azure to activate the integration processes for the Azure data source.

Learn More

Content Packs and their functionality

To learn about Content Packs and their functionality, see Connect the Data Source in theAdministrator
Guide.

Important Information

l The Azure Content Pack supports multiple instances.

l DCS Integration: An extractor using the Data Collection Servicemechanism that extracts entities
from the source and generates corresponding flat files. For details, see Data Collection Service
(DCS) in theAdministrator Guide.
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l All fields are case-sensitive.

l Azuremust be activated with the CSA data source. If you activate Azure alone, only the cost fact
information is displayed, without the ability to drill down further.

Azure Usage Data.

For performance reasons, the ETL job extracts only, at most, 1 month of data for the initial and delta
loads.

Utilization Data.

For performance reasons, the ETL job extracts only, at most, 1 week of data for the initial and delta
loads.

Azure utilization data is based on the latest Microsoft Azure preview portal function. Make sure you
switch on Diagnostic for theMicrosoft Azure Cloud VM instances, to have utilization data returned by
theMicrosoft Azure Cloud Service API.

Limitation:

l You can create Virtual Machines, storage, web apps, and a lot of other components with one
subscription ID under a global account of Azure. If the Virtual Machine type is Windows, BA
can obtain the name of the Cloud Services and provide its utilization data. If the Virtual Machine
type is Linux, BA cannot obtain the name of the Cloud Services and provide its utilization data.
The impact is on the SERVICE_PROVIDER_UTILIZATION_FACT entity.

l In Azure, you can enter your VM namewhen creating the VMs, and it is possible to use the
same VM name for different Cloud Services. Due to the above limitation, the deployment ID is
not displayed in the storage table, making it impossible to know the VM from which themetric
data originates. So it is recommended not to create VMs with the same name.

l When using CSA with Azure Content Pack version: 14.12, and the OOTB design : CSL_BP_
MICROSOFT_AZURE_COMPUTE_3.20_CP3.0, Azure usage related data is displayed in the
CSA-Resource Usage and Utilization for Consumer andCSA_Resource Usage and
Utilization for Resource Supplier Manager reports, but Azure CPU utilization data is not
available and is not displayed in these reports.
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Tasks

This section includes:

Create an application in Azure portal 59

Assign permission to subscriptions in the Azure portal 62

Create the certificate and bind all subscriptions 63

Activate the Integration 65

Create an application in Azure portal

1. To create an application in the Azure portal, open: https://manage.windowsazure.com/ and click
ACTIVE DIRECTORY > Default Directory > APPLICATIONS > ADD > Add an application
my organization is developing.
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2. Click <Application_just_created> > CONFIGURE > keys > Select Duration > Save to get the
key as App password; and the CLIENT ID as App id. They are used when configuring the data
source in ITBA.
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Assign permission to subscriptions in the Azure portal

1. To assign permissions to subscriptions in the Azure portal, open: https://portal.azure.com/ and
click Subscriptions , select the relevant subscription for which the customer wants to view data
in ITBA, click Access (Roles) > Reader .
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2. Click Add and select the application that the customer created for ITBA and click Select.

Note: If, in ITBA, you want to view data frommultiple subscriptions youmust assign the
permissions to each subscription separately using the above procedure.

Create the certificate and bind all subscriptions

1. Generate a self-signed certificate using the JDK keytool:

a. After ITBA is installed, log on to the ITBA Linux server and use the following command in the
command line to generate the certificate:

cd $HPBA_HOME/jdk/bin

keytool -genkey -keyalg RSA -keystore <certificatename>.jks -keysize 2048

where <certificatename> is the name of the certificate you want to create.
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b. Enter the keystore password and the requested information.

c. Convert <certificatename>.jks to <certificatename>.cer and <certificatename>.pfx. using
the following command:

keytool -importkeystore -srckeystore <certificatename>.jks -srcstoretype JKS -

destkeystore <certificatename>.pfx -deststoretype PKCS12

d. Enter destination keystore password. Remember this password which will be used in the
Connect to Data Source page.

Use the same password for destination keystore and source keystore.

e. Enter the following command:

keytool -export -file <certificatename>.cer -keystore <certificatename>.jks

Enter the keystore password.
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2. In the AzureManagement Portal accessed via https://manage.windowsazure.com/, select
SETTINGS > MANAGEMENT CERTIFICATES > UPLOAD.

3. Upload <certificatename>.cer for each subscriptions.

Activate the Integration

1. Select ADMIN > Data Management > Connect Data Source then click Add data source.

2. The Add Data Source page opens. Select the Azure data source type.

3. Select or enter the configuration parameters.

4. Click Next to proceed to the validation page.

Note: If you want to display Azure utilization data returned by theMicrosoft Azure Cloud Service
API, make sure you switch on Diagnostic for theMicrosoft Azure Cloud VM instances.
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UI Description

Azure Activation Page

The following is an example of the Azure Activation page.
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User interface elements are described below:

UI Element Description

Instance
name

Enter a name for the data source instance you are activating.

Azure
Version

Select the relevant Azure version. For details, see theSupport Matrix.

Time Zone Time zonemust be UTC.

Data
Source
Type

GENERIC. This parameter is read only.

Tenant ID The unique ID of the organization in Azure AD that has granted access for your app.

APP ID The unique identifier for your application. Youmust use this if your application
accesses data in another application, such as theMicrosoft Azure AD Graph API.

Input the CLIENT ID that you obtain after creating the relevant application in the
Azure portal.

Note: In Azure, oneGlobal ID can havemultiple subscriptions. To get
consumption data for an Azure subscription, APP ID is required. If you want to
get consumption data for all subscriptions under the Global ID, all subscriptions
are required to be authorized for the same APP ID, which will be added to the
DCS page.

APP
Password

If your app reads or writes data from/to Microsoft Azure AD, such as data that is
made available through theGraph API, your app need a key. The APP Password is
the key that you obtain after creating the relevant application in the Azure portal.

Certificate Once you have created amanagement certificate, (a .cer file with only the public key)
you can upload it into the portal. When the certificate is available in the portal, anyone
with amatching certificate (private key) can connect through theManagement API
and access the resources for the associated subscription.

The absolute path to the .pfx certification file on the ITBA Linux server. For example,

/home/ITBA/Azure_certification.pfx.

Certificate
Password

The keystore password of the .pfx certification.

Proxy Host The proxy host.

Proxy Port The proxy port.

Proxy
Username

The Proxy user name.
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UI Element Description

Proxy
Password

The Proxy password.

Proxy
Domain

The Proxy domain.

Proxy
Workstation

The Proxy workstation.

Initial Load
Period
(month)

Select the number of months from which you want the initial data loaded.

The Initial load period is 1month for usage and 1 week for utilization.

Reference

Azure-Related KPIs and Metrics

The KPIs andMetrics related to the Azure data source are provided in the CSA and CSA_DemoCAPs.
For details, see CSA_Demo and CSA Content Acceleration Packs in theContent Acceleration Packs
Guide.
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Integration with CSA

Cloud Service Automation (CSA) is a platform that orchestrates the deployment of computation and
infrastructure resources and of complex multi-tier application architectures. HP CSA integrates and
leverages the strengths of a hybrid cloud environment, providing the ability to design and deploy
enterprise-ready cloud services tailored to the business needs of your organization. It works through a
catalog-based subscription process. Subscribers request andmodify cloud service offerings with pre-
defined pricing and other customer-specific features. Once the request is approved, through a policy-
driven process, HP CSA deploys the cloud service offering using a structured lifecycle with pre-defined
integrationmechanisms for invoking external processes.

The integration with CSA as new content pack provides reporting analysis based on CSA datamodel.

The purpose of the integration of CSA as a data source is to bring this information into the Data
Warehouse.

This section describes the integration, contexts, KPIs, Metrics, and reports, if any, associated with the
integration with specific data sources.

To access:

Select ADMIN> Data Management > Connect Data Source then click Add data source and select
CSA to activate the integration processes for theCSA data source.

Learn More

Cloud Optimization Offering

The CloudOptimization offering includes integrations with:

l Amazon Web Services (AWS). For details see Integration with AWS in theContent Reference
Guide.

l Amazon Web Service CloudWatch(AWSCW). For details see Integration with AWSCW in the
Content ReferenceGuide.

l Cloud Service Automation (CSA). For details see Integration with CSA in theContent Reference
Guide.
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Other Data Sources

The data from the below data sources is integrated with the data from CSA and displayed in the CSA
CAP pages, KPIs, andMetrcs. For details, see CSA_Demo and CSA Content Acceleration Packs in
theContent Acceleration Packs Guide.

l AmazonWeb Services (AWS) offers a complete set of infrastructure and application services that
enable you to run virtually everything in the cloud: from enterprise applications and big data projects
to social games andmobile apps. One of the key benefits of cloud computing is the opportunity to
replace up-front capital infrastructure expenses with low variable costs that scale with your
business.

The integration with AWS provides cost and usage reports based on the cost allocation report
provided by AWS account.

l Amazon CloudWatch (AWSCW)monitors your AmazonWeb Services resources and the
applications you run on AWS in real-time. You can use CloudWatch to collect and track metrics,
which are the variables you want to measure for your resources and applications. CloudWatch
alarms send notifications or automatically make changes to the resources you aremonitoring based
on rules that you define. For example, you canmonitor the CPU usage and disk reads and writes of
your Amazon Elastic Compute Cloud (Amazon EC2) instances and then use this data to determine
whether you should launch additional instances to handle increased load. You can also use this
data to stop under-used instances to savemoney. In addition tomonitoring the built-in metrics that
comewith AWS, you canmonitor your own custommetrics. With CloudWatch, you gain system-
wide visibility into resource utilization, application performance, and operational health.

l Azure is Microsoft cloud computing platform, a growing collection of integrated services like
analytics, computing, database, mobile, networking, storage, and web, for moving faster, achieving
more, and savingmoney.

l Virtual Performance Viewer (vPV) is a web-based analysis and visualization tool that analyzes
performance trends of elements in virtualized environments. vPV gives you at-a-glance visibility
across your virtual environment for real-time insights into performance, capacity, and health. This
helps you to optimize your infrastructure and quickly solve virtualization and cloud performance
issues. It enables virtualizationmonitoring by providing an overview of the environment, near-real-
time and historical data analysis and triaging using an interactive dashboard. It also enables
monitoring for cloud and hypervisor environments. HPE vPV provides performancemonitoring,
graphing, and reporting in a single interface.
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Important Information

l To learn about Content Packs and their functionality, see Connect the Data Source in the
Administrator Guide.

l The CSA Content Pack supports multiple instances.

l All fields are case-sensitive.

l The CSA ETL job aggregates the CSA Subscription Price with a daily granularity in the target
database. This means that the ETL job gets the price from CSA, converts it into the actual cost
according to the ETL running date, generates a cost record for that day, and stores it in the target
database. For example, if the current date is April 22nd, for themonth of April, after the ETL run has
completed, you see a total of the 22 aggregated records of the CSA subscription Price in the target
database.

l

Example of a CSA subscription price calculation: If, for example, the price of one daily
subscription is $10, you have just used the subscription for 12 hours, and the ETL starts to run
at this moment, the total you have to pay is 10*12/24=$5. The CSA subscription price is
calculated for the real usage accurate to the second. Though some customers would prefer to
see $10 on the report even if the usage is not yet 24 hours, BA displays $5 after the ETL load
because it represents the real usage.

l DCS Integration: An extractor using the Data Collection Servicemechanism that extracts entities
from the source and generates corresponding flat files. For details, see Data Collection Service
(DCS) in theAdministrator Guide.

l

Tip: If you integrate with both CSA and AWS/AWSCW, youmust run the AWS/AWSCW ETL
before the CSA ETL. If you do not run the ETL as recommended, youmust wait for the end of
the CSA ETL run to view the correct data.

l The CSA and CSA_DemoCAPs are associated with the CSA data source, its context, KPIs, and
Metrics. For details, see the CSA_Demo and CSA Content Acceleration Packs in theContent
Acceleration Packs Guide.

l When using CSA with Azure Content Pack version: 14.12, and the OOTB design : CSL_BP_
MICROSOFT_AZURE_COMPUTE_3.20_CP3.0, Azure usage related data is displayed in the
CSA-Resource Usage and Utilization for Consumer andCSA_Resource Usage and
Utilization for Resource Supplier Manager reports, but Azure CPU utilization data is not
available and is not displayed in these reports.
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Tasks

This section includes:

Change the default exchange rate of each currency 72

Configure the BA Website Browser SSL 73

Import the CSA SSL certificate to BA keystore 84

Install the Content Pack 92

Activate the CSA data source 92

Execute the ETL process 97

Activate the relevant CSA CAP 98

Calculate the KPI 99

Configure the Cloud Analytic Tiles in the Provider Portal 100

Support CSA Multiple Currency for Service Offering 106

Configure the Showback report for the Consumer Organization Administrator 106

CSA-Related KPIs andMetrics 132

Change the default exchange rate of each currency

To help you convert the billing amount to different currencies, ITBA has pre-configured their default
exchange rates.

If you want to change the default exchange rate of each currency, open the $HPBA_
HOME/ContentPacks/CSA/EXTERNAL/EXCHANGE.csv file and change the rates.
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Configure the BA Website Browser SSL

1. Log on to BA, and click Continue to this website (not recommended).

2. Click Certificate error and then click View certificates.

3. Click theDetails tab and click Copy to File …
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Click Next.
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Click Next.
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Click theBrowse... button and give a file name, such as CSA45.cer, and click Next.
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Click the Finish button.
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4. Open the Internet Options > Content and click Certificates.
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5. Open the Trusted Root Certification Authorities and click Import… link.
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6. Select the relevant certificate file and click Import.

7. Click Next.
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8. Click Yes.
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9. Open your browser and reopen the BA logon page.
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Import the CSA SSL certificate to BA keystore

1. Export the CSA SSL certificate:

a. Access the CSA portal from the browser of the BA server.

Content Pack 0004 for BA 10.00
Documentation_Additions

HPE IT Business Analytics (10.00)
Monday, March 28, 2016- 7:08:09 AM Page 84 of 182



b. Click the red cross in the URL bar and then click Certificate information.
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c. In the window that pops up, click theDetails tab, and click theCopy to File…button.
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d. In the window that pops up, click Next.
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e. Click Next.
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f. Specify the name of the file you want to export and click Next.
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g. In the next page, click Finish.

The CSA SSL cert file is now exported.

In the above example, the file is located at C:\software\csa-certificate_
fromExplorer.cer%HPBA_Home%/software/csa-certificate_fromExplorer.cer.

2. Open a command prompt and run the following commands:

o In Linux:

keytool -importcert -alias csa -file %HPBA_Home%/software/csa-certificate_
fromExplorer.cer -keystore %HPBA_Home%/jdk/jre/lib/security/cacerts -trustcacerts

o InWindows:

cd <HPBA_Home>\jdk\jre\bin
keytool –importcert –alias csa –file “c:/Software\csa-certificate_fromExplorer.cer” –
keystore C:/%HPBA_Home%/jdk/jre/lib/security/cacerts –trustcacerts
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a. When prompted for the keystore password, type changeit.

b. When prompted to trust this certificate, type yes.

c. Restart theHP IT Business AnalyticsService from Services Windows admin tools.

d. Run%HPBA_Home%/supervisor/bin/hpba-restart.sh to restart BA.

e. Wait a few minutes for the services to fully start.
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Install the Content Pack

1. Make sure you have imported the CSA SSL Certificate (see above).

2. Log on to the BA application.

3. Click ADMIN > Data Management, click Install Content Pack to install the CSA Content Pack.
For details, see Install Content Pack.

Activate the CSA data source

1. Make sure you have imported the CSA SSL Certificate (see above).

2. Log on to the BA application.

3. Make sure you have installed the Content Pack (see above).

4. Click ADMIN > Data Management and the click Connect Data Source .
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5. Click Add data source.
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6. Select the CSA data source type and press Next.
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If theNext button does not appear in theWizard dialog box, click the edge of the Data Source
Wizard and when the black cross appear, move the window upwards until you see theNext
button.

User interface elements are described below:

Note: If the CSA configuration is for a named instance connection, make sure to enter the
named instance port.
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UI Element Description

Instance name Enter a name for the data source instance you are activating.

CSA Version Select the relevant version. . For details, see theSupport Matrix.

Time Zone Select the time zone for the data source.

Data Source Type CSA

This parameter is read only.

Organization Name Enter the Organization Name that is necessary to retrieve admin
details.

The default value is CSA-Provider.

Username Enter your admin username used to log on to CSA. The default
username is ooInboundUser.

Password Enter your admin password used to log on to CSA. The default admin
password is cloud.

Hostname/IP
Address

Enter the CSA server hostname or IP address.

Port Port for REST API (default value is 8444).

Initial Load Period
(months)

Select the number of months from which you want the initial data
loaded.
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7. Enter the CSA configuration parameters and click Next to validate the parameters.

Execute the ETL process

After adding the CSA data source, you need to run the ETL to pull data from CSA source.

You can schedule the running of the ETL process. For details, see Run ETL - Content Flow
Managementin theAdministrator Guide.

1. Log on to the BA application.

2. Make sure you have imported the CSA SSL Certificate (see above).

3. Make sure you have installed the Content Pack (see above).

4. Make sure you have activated the data source (see above).

5. Click ADMIN > Data Management > Run ETL.
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6. Click Add Scheduler to schedule the ETL run or click >. This loads the data from the CSA data
source.

Note: The ETL runmight last some time depending on the volume of data it has to load.

Activate the relevant CSA CAP

Activate the CSA_DemoCAP for demo purposes or activate the CSA CAP for live data into BA.

For live data cases, if you had activated the CSA_Demo previously, youmust deactivate it before you
activate the CSA CAP.

1. Log on to the BA application.

2. Ignore theUnreachable Java Applet. Click OK.

3. Make sure you have imported the CSA SSL Certificate (see above).

4. Log on to the BA application.

5. Make sure you have installed the Content Pack (see above).

6. If you plan to activate the CSA_Demo proceed to the next step. If you plan to activate the CSA,
make sure you have executed the ETL (see "Execute the ETL process" on the previous page).

7. Click ADMIN > Data Management and click Activate CAP.

8. Select theCSA or theCSA_Demo in the list of CPs, and click Activate to activate the CAP.
Click Yes to begin the activation process.
Then wait until the CAP activation is successful.

9. Close theADMIN tab.
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Calculate the KPI

1. Log on to the BA application.

2. Click theSTUDIO tab and click the calculation tool and select Recalculate.

a. Select theCSA_CloudOptimization in theUniverse/Context for recalculation list.

b. Select the recalculation start date.

c. Check the check box.

d. Click Calculate.

The calculationmay take a few minutes.

3. To check the KPI calculation status, click the calculation tool and select Calculation
monitoring.
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4. Select Calculations running now in theMonitoring options.

If No items to show is displayed, the KPI calculation is finished.

Now you can view the CSA dashboard pages with live data.

You can schedule the Scheduled calculation of the KPI. For details, see Calculation Scheduling in
theBusiness Analyst Guide.

Configure the Cloud Analytic Tiles in the Provider Portal

1. Create a user in ITBA with the same login name as in CSA.

a. From the ITBA ADMIN tab, create an ITBA user account with same login name as CSA
(admin). The password does not need to be the same. The password needs to be complex.
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b. Log out from ITBA, and log on again in as the administrator.

c. Select the pages relevant to CSA andmake sure you can see the pages with live data.

2. Configure single sign-on:

a. Enable SSO between the CSA Cloud ServiceManagement Console (SMC) and BA. For
details, see "Enabling the Cloud Analytics Secondary Tiles" in theHP Cloud Service
Automation Configuration Guide.

Enable SSO between theMarketplace Portal (MPP) and BA. For details, see "Configure the
Showback Report Tile" in theHP Cloud Service Automation Configuration Guide.

b. In CSA, initString is configured in the crypto element in the
%CSA_HOME%\jboss-as-7.1.1.Final\standalone\deployments\csa.war\WEB-
INF\hpssoConfiguration.xml file.

The initString value represents a secret key and should be treated as such in your
environment.

Navigate to the <crypto> tag and enter the relevant value in the initString parameter. 

Content Pack 0004 for BA 10.00
Documentation_Additions

HPE IT Business Analytics (10.00)
Monday, March 28, 2016- 7:08:16 AM Page 101 of 182



c. In BA, click ADMIN > Settings > Single Sign-on and set the LW-SSO Token Creation key
(initString) with the key above (without the double-quote and without the string “initString”).
Change the domain name to the BA server domain (CSA server should have the same domain
name). Click Save.

3. Configure the embedded page URL:

a. In CSA server, backup the%CSA_HOME%/jboss-as-
7.1.1.Final/standalone/deployments/csa.war/dashboard/config.json file (where%CSA_
HOME% is the directory in which Cloud Service Automation is installed).

b. Edit the config.json file.
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c. Search for the id: executive_scorecard tile (beware there are two such tiles), start from the
second (type = secondary) as shown below:

d. Under the tiles node, change “enabled”: false to “enabled”: true, for the following ids:

i. Executive_scorecard_resource_manager

ii. Executive_scorecard_service_business_manager

iii. Executive_scorecard_showback_report

e. Do not change it in the id: executive_scorecard_standalone.

f. Change “enabled”: true to “enabled”: falsein the id: assistance_executive_scorecard.
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g. For all tiles that are under the id: executive_scorecard, in the data section, change
<CONFIGURE_HOST_NAME> to match the hostname of your Business Analytics
installation. For example xs.example.com.

4. Access BA pages in the CSA system:
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a. Log on to CSA using the full qualifier domain name (FQDN) URL.

b. Open the embedded BA pages in the CSA system.
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Support CSA Multiple Currency for Service Offering

1. Edit EXCHANGE.csv.

2. UploadEXCHANGE.csv to%HPBA%/ContentPacks/CSA/EXTERNAL in the BA server.

3. Run the ETL to import exchange data. For details, see Run ETL - Content Flow Managementin the
Administrator Guide.

Configure the Showback report for the Consumer Organization

Administrator

In this section, we simulate the CSA Consumer Organization administrator use case that leverages
two existing groups in the LDAP server. Each group can only see its own group's data. CSAEngineers
group can only see the engineering group data and the CSAHR group can only see the HR group data.
For details, see also Setting access restrictions on a universe in theUniverse Designer for
BusinessObjects XI 3.1.

"Step 1 - Configure resource, user and permission" on the next page

"Step 2 - Configure the restriction of Cloud Billing universe" on page 117

"Step 3 - Configure the Business Analytics tile in the CSA Market Place Portal" on page 129
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Step 1 - Configure resource, user and permission

1. In the CSA integrated LDAP server, select 2 groups: CSAHR and CSAEngineers.
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2. In the ITBA application, configure LDAP. For details, see LDAP Management in theAdministrator
Guide.

Create the CSAengineers and CSAHR groups and assign them users.

3. Create the resource for the CSA-Showback for Consumer Organization Admin page.
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4. Create the CSAreportviewer role.

5. Assign the role CSAreportviewer to two groups.

6. Configure LDAP with BOE. For details, see LDAP in BusinessObjects in theAdministrator Guide.
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7. Configure the group permission in the BOE server:

a. Log on to BusinessObjects Central Management Console (http:// <local BOE server
name>:8080/BOE/CMC) using the administrator name and password and configure
LDAP with BOE. For details, see LDAP in BusinessObjects in theAdministrator Guide.

b. Open the Connections:
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c. Select the XS_DWH_JDBC connection that your report uses and click User Security.

d. Grant theView On Demand permission to the two groups.

8. Open the Universes.
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9. Select theCloudBilling universe that your report uses and click Universe Security.
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10. Add thePrivate security to the two groups.

11. Grant theView on Demand permission to the 2 groups inUser Security.
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12. Select Folders.
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13. Select theShowback for Consumer Organization Admin report and click User Security.
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14. Grant theView On Demand to the 2 groups.
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Step 2 - Configure the restriction of Cloud Billing universe

1. Configure the restrictions of the Cloud Billing universe:

a. On the BOE server, install SAP BusinessObjects BI platform 4Client Tools. Unzip the bip-
client.ZIP file from installation file and click setup.exe to install it.

Content Pack 0004 for BA 10.00
Documentation_Additions

HPE IT Business Analytics (10.00)
Monday, March 28, 2016- 7:08:29 AM Page 117 of 182



b. Open the Universe Design Tool.

c. Log on to the Universe Design using the BOE administrator.
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d. Click the Import button.

e. Open the Cloud Billing universe.
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f. Add the relevant restrictions in theManage Access Restrictions wizard:

l Engineer_restriction is set for CSAengineers which is configured to see only the
engineering group’s data.

l HR_restriction is set for CSAHR which is configured to see only the HR group’s data.
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g. Create the restriction.
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i. Click New in the wizard.

ii. Click theRows tab and click Add....
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iii. Select theXS_BUSINESS_UNIT_DIM_V table in the Table list, and set the SQL query
in as follows:

iv. Click OK.

v. Add restrictions1 as XS.BUSINESS_UNIT_DIM_V.Name = ‘Engineering’.
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vi. Click OK.

h. Repeat the steps from "Create the restriction. " on page 122 to create the second restriction.
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2. Click theAdd user orAdd group button, select the user and click the > button.
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3. Click OK.

4. Select Engineers_Restriction inAvailable Restrictions area, select theCSAengineers group
in theAvailable groups and users area, and then click the >>Apply button.
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5. Repeat the previous step for theHR_Restriction and the HR group.

6. Click Export...

7. Click OK.

8. Log on to BA as the HR group one user and open the CSA billing report in the Dashboard.
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9. Click theRefresh button to display the following value for Org Name.

10. Log on BA as the Engineers group one user and open the CSA billing report in the Dashboard.

11. Click theRefresh button to display the following value for Org Name.

Step 3 - Configure the Business Analytics tile in the CSA Market Place Portal

To enable and configure the Showback report on the CSA Market Place Portal for the Consumer
Organization Administrator persona:

1. Locate the%CSA_HOME%\portal\conf\dashboard.json file.

2. In the file, locate the section below and in the highlighted url replace the <CONFIGURE_HOST_
NAME> placeholder with the host name of the BA instance.
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{
"label": "common.section.ADMINISTRATION.label",
"role": ["CONSUMER_ORGANIZATION_ADMINISTRATOR"],
"tiles": {
"default": {
"className": "light-gray"

},
"items": [{
"label": "common.items.MANAGE_USER_SUBSCRIPTIONS",
"icon": {
"className": "icon-manage-subscriptions"

},
"link": "#/user/manage"

}, {
"label": "common.items.SCORECARD",
"icon": {
"className": "icon-status"

},
"link": {
"url":"https://<CONFIGURE_HOST_

NAME>/fndwar/loadEmbeddedPage.jsp?com.hp.bsm.uim.pageUID=ef63ab7f-b86b-43c8-
b8d8-bb81869b73dc",

"target": "_blank"
}

}]
}

}

3. Save.
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UI Description

CSA Activation Page

The following is an example of the CSA Activation page.

User interface elements are described below:

Note: If the CSA configuration is for a named instance connection, make sure to enter the named
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instance port.

UI Element Description

Instance name Enter a name for the data source instance you are activating.

CSA Version Select the relevant version. . For details, see theSupport Matrix.

Time Zone Select the time zone for the data source.

Data Source Type CSA

This parameter is read only.

Organization Name Enter the Organization Name that is necessary to retrieve admin details.

The default value is CSA-Provider.

Username Enter your admin username used to log on to CSA. The default username
is ooInboundUser.

Password Enter your admin password used to log on to CSA. The default admin
password is cloud.

Hostname/IP Address Enter the CSA server hostname or IP address.

Port Port for REST API (default value is 8444).

Initial Load Period
(months)

Select the number of months from which you want the initial data loaded.

Reference

CSA-Related KPIs and Metrics

For a list of the KPIs andMetrics related to the Cloud Service Automation data source, see KPIs and
Metrics in theContent Acceleration Packs Guide.
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CSA_Demo and CSA Content Acceleration Packs

The purpose of the CSA_Demo and CSA Content Acceleration Packs (CAPs) is to provide a set of
items (Scorecards, Contexts, KPIs, Metrics, andmore) that automatically gathers information from
across your enterprise to build key performance indicators (KPIs) related to CSA-related issues with
OOTB data from DataWarehouse as well as Dashboard pages that display the relevant information.
The CAPs include the Cloud Server Automation Perspectives. The CAPs provide broad and deep
insight that should enable you to Increase Service Profitability, Optimize Resource Provider
Relationship, Improve Resource Utilization. This CAP provides a 360 degree Cloud Service
Automation view.

The CSA is based on the Cloud Service Automation, AmazonWeb Services, and AmazonWeb
Service CloudWatchdata sources.

The CSA_Demo takes its data from out-of-the-box .CSV files included in the CAP.

To access:

Click Admin > Data Management > Activate CAP. You can then select the relevant CAP and
activate it.

If the CAP you want to activate is not the demoCAP, youmust make sure you have installed the
relevant Content Pack, connected the relevant data source, optionally configured the consolidations,
and run the ETL to see the relevant data in the CAP Dashboard pages.

Learn More

What are Content Acceleration Packs (CAPs)

Content Acceleration Packs (CAPs) are packages that include Dashboard pages that display
Scorecards and components, KPIs, Metrics, Contexts (universes), data (from .CSV files or from data
sources), and documentation for the CAP. You can import them, export them, activate, or deactivate
them, or you can create your own.

CAPs describe typical stories that show how the correct implementation of Business Analytics drives
Performance Improvement and Cost Reduction for the IT organization.
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CAPs demonstrate Business Analytics capabilities, and helps you add basic elements that can be
used to customize your Dashboard.

The CSA_Demo is based on data in .csv files that are part of the CAP package and CSA CAPs include
data from data sources.

Reports

l The CSA-Showback for Cloud Services report displays the subscription cost incurred by each
organization during the time period you specified when you opened the report. for details, see CSA-
Related Reports in theContent ReferenceGuide.

l To view data in the CSA-related reports, make sure you have installed BOE.

l The cloud-related reports (Dashboard pages) provided in the CSA_CAP and CSA_Demo_
CAP CAPs combine integrated data from the following data sources Cloud Service Automation
(CSA), AmazonWeb Services (AWS), AmazonWeb Service CloudWatch (AWSCW)

Pages

CAP Page

CSA_Demo l "CSA - Amazon EC2 Instance Usage and Utilization" on the next page

l "CSA-Showback for Cloud Services" on the next page

l "CSA-Showback Detail for Cloud Services" on page 137

l "CSA_Demo and CSA Content Acceleration Packs" on the previous page

l "CSA-Showback Detail for Consumer " on page 138

l "CSA-Cloud Service Automation Overview" on page 139

l "CSA-Organization" on page 139

l "CSA-Resource Supply Manager" on page 140

l "CSA-Resource Usage and Utilization for Consumer" on page 141

l "CSA-Resource Usage and Utilization for Resource Supplier Manager" on page
142

l "CSA-Service Business Manager" on page 143

l "CSA-Service Business Manager_Extended" on page 143

l "CSA-World Map" on page 144

l "CSA-US Map" on page 145

CSA l "CSA - Amazon EC2 Instance Usage and Utilization" on the next page
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CAP Page

l "CSA-Showback for Cloud Services" below

l "CSA-Showback Detail for Cloud Services" on page 137

l "CSA-Showback for Consumer Organization Admin " on page 137

l "CSA_Demo and CSA Content Acceleration Packs" on page 133

l "CSA-Showback Detail for Consumer " on page 138

l "CSA-Cloud Service Automation Overview" on page 139

l "CSA-Organization" on page 139

l "CSA-Resource Supply Manager" on page 140

l "CSA-Resource Usage and Utilization for Consumer" on page 141

l "CSA-Resource Usage and Utilization for Resource Supplier Manager" on page
142

l "CSA-Service Business Manager" on page 143

l "CSA-Service Business Manager_Extended" on page 143

CSA - Amazon EC2 Instance Usage and Utilization

The data sources are AWS and AWSCW.

CSA-Showback for Cloud Services

The CSA-Showback for Cloud Services report displays the subscription cost incurred, during the time
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period specified when the user opened the report, by the organizations for which the user has
permission. It also displays the Option Full Name, Property Name, Property Value, and Cost for each
selected user subscription. The period granularity of this report is daily. You can search by specific date
range, by user name, or by organization name.

The CSA-Showback for Cloud Services report displays the subscription cost incurred by each
organization based on demo data.
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CSA-Showback Detail for Cloud Services

The report displays the option and property cost for each selected user subscription. The period
granularity of this report is daily. The user can search by specific date range, by user name, by
organization name, or by subscription name.

CSA-Showback for Consumer Organization Admin

The CSA-Showback for Consumer Organization Admin report displays the subscription cost incurred
by each organization during the time period you specified when you opened the report for the Admin
user.
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CSA-Showback Detail for Consumer
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CSA-Cloud Service Automation Overview

CSA-Organization
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CSA-Resource Supply Manager
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CSA-Resource Usage and Utilization for Consumer

The persona is the resource supply manager, who is responsible for themanagement of equipment,
hardware, and other logistical details of a company or a company’s division.

Since the traditional IT is transforming to the new style of IT by moving IT assets to the cloud, His job is
to manage each resource provider; deliver the infrastructure service to support the business application
and service run in the company; make sure the overall cost of resource provider is under control.

In this report, the private cloud VM instance cost is based on the based rate inputed by user multiplied
by real VM usage. Other usage and utilization are directly from VM.

The report only displays the VM that created by CSA subscription, if the VM has no linkage to CSA
subscription, it should display on this report.

The report is at daily level. User will able to filter start time and end time, organization, resource
provider.
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CSA-Resource Usage and Utilization for Resource Supplier Manager
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CSA-Service Business Manager

CSA-Service Business Manager_Extended

Note: This page is only available on your mobile device.
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CSA-World Map

This page is only available with the CSA_DemoCAP. For details, see CSA_Demo and CSA Content
Acceleration Packs in theContent Acceleration Packs Guide.
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CSA-US Map

This page is only available with the CSA_Demo.

Tasks

This section includes:

Upload andmanage the Content Acceleration Pack 145

View the CAP-related Dashboard pages 146

View the Scorecard Structure and KPI andMetric Breakdowns in the Studio 146

Activate the CSA_Demo in ITBA 146

Deactivate the CSA_Demo and activate the CSA CAP 147

CSA_Demo and CSA 149

Upload and manage the Content Acceleration Pack

For details , see Content Acceleration Packs (CAPs).
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View the CAP-related Dashboard pages

1. In the ITBA application, close all the tabs. The Dashboard is displayed.

2. Click the tab corresponding to the relevant CAP page (for details, see "Pages" on page 134) in the

Dashboard. If it is not displayed, click thePage Gallery button in the Dashboard toolbar,

double-click the relevant page icon and close the PageGallery dialog box.

View the Scorecard Structure and KPI and Metric Breakdowns in the Studio

1. Make sure the CAP is activated.

2. In the Business Analytics application, click Studio.

3. Expand the relevant Scorecards to view the Scorecards, Perspectives, Objectives, KPIs,
KPI Breakdowns structure.

Activate the CSA_Demo in ITBA

To activate the CSA_Demo you do not need to connect to a live CSA source.

1. Log on to the ITBA application.

2. Ignore theUnreachable Java Applet. Click OK.
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3. Click theADMIN > Data Management > Activate CAP.

4. Select CSA_Demo in the list of CPs, and click Activate to activate the CAP. Click Yes to begin
the activation process.
Then wait until the CAP activation is successful.

5. Close theADMIN tab.

6. In the Dashboard, click Select Page and select the pages that are relevant for CSA. For details,
see "Pages" on page 134.

The pages display demo data.

Note: If the CSA-Billing Statement for Cloud page displays a blank screen with the titleWeb

Intelligent Report Viewerand a shield icon is displayed in the URL bar (top right-hand

corner), click the shield and allow script to run. After a few seconds, the page will display
data.

Deactivate the CSA_Demo and activate the CSA CAP

If you have activated the CSA_Demo previously, youmust deactivate if before you activate the
CSA CAP.

1. Log on to the ITBA application.

Content Pack 0004 for BA 10.00
Documentation_Additions

HPE IT Business Analytics (10.00)
Monday, March 28, 2016- 7:08:56 AM Page 147 of 182



2. Ignore theUnreachable Java Applet. Click OK.

a. Click theADMIN > Data Management > Activate CAP.

3. Select CSA_Demo in the list of CPs, and click Deactivate to deactivate the CAP. Click Yes to
begin the deactivation process.
Then wait until the CAP deactivation is successful.

4. Select CSA in the list of CPs, and click Activate to activate the CAP. Click Yes to begin the
activation process.
Then wait until the CAP activation is successful.

5. Close theADMIN tab.
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UI Description

CSA_Demo and CSA
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User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Pages See "Pages" on page 134.

Scorecards l Cloud Server Automation

Business
Contexts

l CSA_CloudOptimization

l CSA_Demo

For details, see Reference: Contexts (Universes) in theContent ReferenceGuide.

KPIs and
Metrics KPIs

l Average Cost of IT Services KPI

The average cost of services provided by IT.

l Average Cost of Resource Providers KPI

The average cost of the Resource Providers during themeasurement period.

l Average Expense for Services KPI

The average expense of services consumed by the organization.

l Average Revenue of Services KPI

The average revenue of services provided by IT during themeasurement period.

l Number of Service Subscriptions KPI

The number of Service subscriptions created during themeasurement period.

l Percentage of DiskSpace Utilization KPI

The average of percentages of diskspace utilization at instance level.

l Percentage of Memory Utilization KPI

The average of percentages of memory utilization at instance level.

l Percentage of Pagefile Utilization KPI

The average of percentages of pagefile utilization at instance level.

l Percentage of Server Utilization KPI

The average of percentages of CPU utilization at instance level.

l Percentage of Swap Utilization KPI

The average of percentages of swap utilization at instance level.

l Percentage of Volume Utilization KPI

The average of percentages of volume utilization at instance level.
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UI Element Description

l Public vs Private Cloud Spending KPI

The ratio between the public and the private spending.

l Service Profit Margin KPI

The profit margin of the services provided by IT during themeasurement period.

l Service Subscription Lifespan KPI

The average lifecycle time of a subscription to a service during themeasurement
period.

l Total Cost of IT Services KPI

The total cost of services provided by IT during themeasurement period.

l Total Cost of Resource Providers KPI

The total cost of the Resource Providers during themeasurement period.

l Total Expense for Services KPI

The total expense of services consumed by the organization.

l Total Revenue of Services KPI

The total revenue of service provided by IT during themeasurement period. In
addition, the following KPIs are also available in the CSA_DemoCAP only:

a. Total Revenue of Services for US Map: The total revenue of service
provided by IT during themeasurement period (this KPI is created for US Map
component).

b. Total Revenue of Services for World Map: The total revenue of service
provided by IT during themeasurement period (this KPI is created forWorld
Map component).

l Total Revenue of Services for US Map KPI (see Total Revenue of Services
KPI)

l Total Revenue of Services for World Map KPI (see Total Revenue of Services
KPI)

Metrics:

l Amount of Used Disk Metric

The product of the amount of disk provisioned and the number of days the VM has
been running. For example, if a VM has been running with 20GB of hard disk for 5
days, the DiskDays is calculated as 20x5 = 100 Disk (GB)-Days.

l Amount of Used Memory Metric

The product of the amount of memory allocated and the number of days the VM
has been running. For example, if a VM has been running with 4 GB of memory for
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UI Element Description

5 days, theMemDays is calculated as follows: 5x4 = 20Memory (GB)-Days.

l Amount of Used Storage Metric

The number of TBs of storage that are currently in use.

l Compute Hours Metric

The number of hours during which the VM has been running.

l Incoming Network Traffic Metric

Network Download.

l Network Traffic Metric

Total network traffic.

l Number of Used CPUs Metric

The product of the number of CPUs and the number of days the VM has been
running. For example, if 4 CPUs are used for the first 15 days and 8 CPUs are
used for the next 15 days in amonth, the CPUDays is calculated as follows:
(4x15)+(8x15) = 180 CPUDays

l Number of Used Instances Metric

The number of dedicated instances you are running in your hybrid cloud
environment.

l Outgoing Network Traffic Metric

Network Upload.

Data
(External
Tables)

l CSA_BILLING_FACT_V

l CSA_BUSINESS_UNIT_DIM_V

l CSA_CLOUD_BILLING_UTIL_FACT_V

l CSA_CLOUD_INF_UTILIZATION_FACT_V

l CSA_COMPONENT_DIM_V

l CSA_CONSUMER_DIM_V

l CSA_Demo

l CSA_GLOBAL_MAP_DIM_V

l CSA_LOCATION_DIM_V

l CSA_Map_Demo

l CSA_NODE_DIM_V

l CSA_OPTION_PROPERTY_DIM_V

l CSA_PERIOD_DIM_V

l CSA_RESOURCE_PROVIDER_DIM_V
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UI Element Description

l CSA_PERSON_DIM_V

l CSA_SERVICE_CATEGORY_DIM_V

l CSA_SERVICE_INSTANCE_DIM_V

l CSA_SERVICE_OFFERING_DIM_V

l CSA_SERVICE_PROVIDER_BILLING_FACT_V

l CSA_SUBSCRIPTION_DIM_V

l CSA_REQUEST_OPTION_DIM_V

l CSA_SERVICE_REQUEST_DIM_V

l CSA_SHOWBACK_DETAIL_FACT_V

l CSA_US_MAP_DIM_V
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Integration with SA

This section describes the integration, contexts, KPIs, Metrics, and reports, if any, associated with the
integration with the Server Automation data source.

Server Automation (SA) enables you to govern the full spectrum of your softwaremanagement
requirements. With SA policy-based softwaremanagement you can automate software installation and
application configuration, and ensure that managed servers are compliant with software policies.

Note: Information about the ALT data source andmore general content issues are detailed in the
Content ReferenceGuide.

The purpose of the integration of SA  as a data source is to bring quality management information into
the DataWarehouse.

To access:

Select ADMIN > > Data Management > Connect Data Source then click Add data source and
select SA to activate the integration processes for theSA data source.

Learn More

Content Packs and their functionality

To learn about Content Packs and their functionality, see Connect the Data Source in theAdministrator
Guide.

Important Information

l The SA Content Pack supports multiple instances.

l All fields are case-sensitive.

Tasks

This section includes:

Activate the Integration 155
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Activate the Integration

1. Prerequisite:

o Make sure that the Server Automation Platform is ready for use, meaning a set of APIs and a
runtime environment that facilitate the integration and extension of SA.

o Check theSupport Matrix for supported versions.

2. Select ADMIN > Data Management > Connect Data Source then click Add data source.

3. The Add Data Source page opens. Select theSA data source type.

4. Select or enter the configuration parameters.

5. Click Next to proceed to the validation page.
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UI Description

SA Activation Page

Mandatory fields aremarked with a red asterisk.

User interface elements are described below:

UI Element Description

Instance name Enter a name for the data source instance you are activating.
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UI Element Description

SA Version Select the relevant SA version. For details, see theSupport Matrix.

Time Zone Select the time zone for the data source.

Data Source Type Oracle

This parameter is read only.

User Enter your username used to log on to the SA database.

Password Enter your password used to log on to the SA database.

Hostname/IP
Address

The remote server on which the SA database resides.

Port Enter the port in the SA server which waits for connections from the SDK
Client side. By default, the port number is 443.

Enter the port of the SA DB. By default, the port number is 1521.

SID Enter the unique name of the database.

Service Name Enter the alias used when connecting.

Initial Load
Period (months)

Select the number of months from which you want the initial data loaded.

Reference

SA-Related KPIs and Metrics

For details about the KPIs andMetrics related to the integration with SA, see KPIs andMetrics in the
Content Acceleration Packs Guide.
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SA_Demo and SA Content Acceleration Packs

The purpose of the SA Content Acceleration Pack (CAP) is to provide a set of items (Dashboard
pages, Scorecards, Contexts, KPIs, Metrics, andmore) that automatically gathers information from
across your enterprise to build key performance indicators (KPIs) related to SM-related issues with
OOTB data from DataWarehouse. The CAP includes the Server Automation Perspectives. The CAP
provides a 360 degree Server Automation view.

To access:

Click Admin > Data Management > Activate CAP. You can then select the relevant CAP and
activate it.

If the CAP you want to activate is not the demoCAP, youmust make sure you have installed the
relevant Content Pack, connected the relevant data source, optionally configured the consolidations,
and run the ETL to see the relevant data in the CAP Dashboard pages.

Learn More

What are Content Acceleration Packs (CAPs)

Content Acceleration Packs (CAPs) are packages that include Dashboard pages that display
Scorecards and components, KPIs, Metrics, Contexts (universes), data (from .CSV files or from data
sources), and documentation for the CAP. You can import them, export them, activate, or deactivate
them, or you can create your own.

CAPs describe typical stories that show how the correct implementation of Business Analytics drives
Performance Improvement and Cost Reduction for the IT organization.

CAPs demonstrate Business Analytics capabilities, and helps you add basic elements that can be
used to customize your Dashboard.

The SA CAP includes data from the Server Automation data source.
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Pages

SA-Compliance Dashboard

SA-JOB Status Dashboard
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SA-Server Automation Overview

Tasks

This section includes:

Upload andmanage the Content Acceleration Pack 160

View the CAP-related Dashboard pages 160

View the Scorecard Structure and KPI andMetric Breakdowns in the Studio 161

User Story 161

SA_Demo and SA CAPs 162

Upload and manage the Content Acceleration Pack

For details , see Content Acceleration Packs (CAPs).

View the CAP-related Dashboard pages

1. In the Business Analytics application, close all the tabs. The Dashboard is displayed.

2. Click the tab corresponding to the relevant CAP page (for details, see "Pages" on the previous

page) in the Dashboard. If it is not displayed, click thePage Gallery button in the Dashboard

toolbar, double-click the relevant page icon and close the PageGallery dialog box.
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View the Scorecard Structure and KPI and Metric Breakdowns in the Studio

1. Make sure the CAP is activated.

2. In the Business Analytics application, click Studio.

3. Expand the relevant Scorecards to view the Scorecards, Perspectives, Objectives, KPIs,
KPI Breakdowns structure.

User Story

1. Scott is the IT Security and Compliance Analyst of ABC Inc. IT Security organization.

2. One of his responsibilities is to ensure that all themanaged nodes are compliant.

3. Scott logs on the ITBA application and opens the Job Status page in the Dashboard tomake sure
that all server automation jobs have completed successfully in the last period. He sees that the
status of all job-related KPIs is green.

4. Scott then switches to the Compliance Dashboard and looks at thePercentage of Successful
Install Patch JobsKPI to see if it meets the target. He finds out that the latest KPI value is
orange.

5. The Historical View shows the poor weekly performance of the KPI for the past few days. In
addition, based on the current results, the Forecast is a continuous decline for the next week and
in the future.

6. Drilling into the details, Scott then looks at theCompliance Node ResultsPie Chart, and
understands how many servers are not compliant. He also notices that there are still a couple of
nodes that are not compliant causing the red status of the KPI.

7. He then clicks onNon-compliant in the legend to open the KPI EXPLORER to see the data set
that lists all the servers that are not compliant.

8. Scott decides to setup ameeting with Chris who is the ComplianceManager of the IT organization
responsible for enforcing the IT compliance policy. They come up with a plan to return the node
compliance status back to normal for all managed nodes.
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UI Description

SA_Demo and SA CAPs

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):
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UI Element Description

Pages See "Pages" on page 159.

Scorecards l Server Automation

Business
Contexts

l Server Automation

l SA_Demo

For details, see Reference: Contexts (Universes) in theContent ReferenceGuide.

KPIs and
Metrics Note: The DemoCAP includes KPIs with names followed by (Demo). The

CAP includes the same KPIs with names that do not include (Demo). The KPIs
are the same but have different names so that both the DemoCAP and the CAP
can be activated at the same time.

l Average Time to Run a Remediation Job KPI

The average time it takes to run a remediation job.

l Average Time to Run an Audit Job KPI

The average time it takes to run an audit job.

l Average Time to Run an Install Patch Job KPI

The average time it takes to run an install patch job.

l Average Time to Run an Install Software Job KPI

The average time it takes to run an install software job.

l Frequency of Audit Policy Checks KPI

Measures how frequently compliance checks are running during themeasurement
period.

l Mean Time to Recover from Non-Compliance KPI

The length of time it takes and the service level to which a business process must
be restored after a non-compliance in order to avoid unacceptable consequences
associated with a break in business continuity.

l Percentage of Compliant Nodes KPI

The number of compliant nodes relative to the total number of nodes.

l Percentage of Managed Nodes KPI

The number of managed nodes relative to the total number of nodes.

l Percentage of Successful Audit Jobs KPI

The number of successful audit jobs relative to the total number of audit jobs.

l Percentage of Successful Install Patch Jobs KPI
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UI Element Description

The number of successful patch jobs relative to the total number of patch jobs.

l Percentage of Successful Install Software Jobs KPI

The number of successful software jobs relative to the total number of software
jobs.

l Percentage of Successful Remediation Jobs KPI

The number of successful remediation jobs relative to the total number of
remediation jobs.

Metrics

l Compliance Node Results Metric

The number of compliance results.

l Number of Compliance Jobs Metric

The number of compliance jobs.

l Number of Nodes Monitored by SA Metric

The number of nodes monitored by SA.

Data
(External
Tables)

SA_Demo
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Integration with vPV

The integration with VPV (Virtual Performance View) as a data source enables accessing vCenter and
HP Helion data.

The purpose of the integration of VPV as a data source is to bring this information into the Data
Warehouse.

Virtual Performance Viewer (vPV) is a web-based analysis and visualization tool that analyzes
performance trends of elements in virtualized environments. vPV gives you at-a-glance visibility across
your virtual environment for real-time insights into performance, capacity, and health. This helps you to
optimize your infrastructure and quickly solve virtualization and cloud performance issues. It enables
virtualizationmonitoring by providing an overview of the environment, near-real-time and historical data
analysis and triaging using an interactive dashboard. It also enables monitoring for cloud and hypervisor
environments. HPE vPV provides performancemonitoring, graphing, and reporting in a single interface.

The data extracted from vPV is correlated to the data available in the KPIs and reports available in the
CSA CAP. For details, see CSA_Demo and CSA Content Acceleration Packs in theContent
Acceleration Packs Guide.

To access:

Select ADMIN > Data Management > Connect Data Source then click Add data source and select
VPV to activate the integration processes for theVPV data source.

Learn More

Content Packs and their functionality

To learn about Content Packs and their functionality, see Connect the Data Source in theAdministrator
Guide.

Important Information

l The VPV Content Pack supports multiple instances.

l DCS Integration: An extractor using the Data Collection Servicemechanism that extracts entities
from the source and generates corresponding flat files. For details, see Data Collection Service
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(DCS) in theAdministrator Guide.

l All fields are case-sensitive.

l VPV must be activated with the CSA data source. If you activate VPV alone, only the cost fact
information is displayed, without the ability to drill down further.

Note: When configuring VPV reports:

l VPV Custom reports are not supported, therefore it is recommended to select theDaily report
option.

l Only cost reports are supported.

l When you generate a report in vCenter Chargeback Manager, you cannot select the following
values:

o Disk Read

o Disk Write

o Network Transmitted

o Network Received

Although the combined disk read and write utilization data and the combined network
transmitted and received utilization data can be fetched and included in the report, the split
utilization data for disk read, disk write, network transmitted, and network received is
unavailable.

When using both the AWS and VCM data sources. Both the AWS and the VCM data sources offer
the same type of information. If you integrate with both data sources, the values provided by the
relevant Metrics might combine. For example, the Number of Used Instances Metric calculates how
many VMs users are using the hybrid cloud environment. Both of the AWS data source (100
VM subscriptions) and the VCM data source (300 VM subscriptions) include this information. If, for
example, you work with AWS only, the Number of Used Instances Metric is 100. If you work with
VCM only, the Number of Used Instances Metric is 300. If you work with both data source, the Number
of Used Instances Metric is 400.

The cloud-related reports (Dashboard pages) provided in the CSA_CAP and CSA_Demo_CAP CAPs
combine integrated data from the following data sources Cloud Service Automation (CSA), Amazon
Web Services (AWS), AmazonWeb Service CloudWatch (AWSCW)

For details, see CSA_Demo and CSA Content Acceleration Packs in theContent Acceleration Packs
Guide.
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Tasks

This section includes:

Activate the Integration

1. Select ADMIN > Data Management > Connect Data Source then click Add data source.

2. The Add Data Source page opens. Select the VPV data source type.

3. Select or enter the configuration parameters.

4. Click Next to proceed to the validation page.

Change the default price of the vPV private cloud resources

To help you calculate the cost for vPV supported private cloud resources (CPU, Memory, Disk), ITBA
has pre-configured their default prices.

To change the default price:

1. Log on to the ITBA server.

2. Edit the last column in thePRICING_MODEL.csv located in $HPBA_
Home/ContentPacks/vPV/EXTERNAL. The column provides the unit price.

3. Save.

The new pricingmodel will be valid in the next ETL run.

Content Pack 0004 for BA 10.00
Documentation_Additions

HPE IT Business Analytics (10.00)
Monday, March 28, 2016- 7:09:03 AM Page 167 of 182



UI Description

VPV Activation Page

The following is an example of the VPV Activation page for MS SQL server.

User interface elements are described below:

For the SQL server:
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If the VPV configuration is for a named instance connection, make sure to enter the named instance
port.

UI Element Description

Instance name Enter a name for the data source instance you are activating.

VPV Version Select the relevant VPV version. For details, see theSupport Matrix.

Time Zone Time zonemust be UTC.

Data Source Type VPV. This parameter is read only.

vpvUsername Enter your username used to log on to the VPV web application.

vpvPassword Enter your password used to log on to the VPV web application.

Hostname/IP Address Enter the hostname or IP address on which VPV is installed.

Port Port for VPV web application.

Initial Load Period
(months)

Select the number of months from which you want the initial data
loaded.

Reference

vPV-Related KPIs and Metrics

The KPIs andMetrics related to the integration with vPV are part of the integration with CSA. For
details, see "CSA-Related KPIs andMetrics" on page 132.
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CP0001 Enhancements and Their Documentation

Enhancements

The CSA Content Pack 0001 supports the following functionality:

1. A new billing details report (Showback Details for Cloud Services) shows the option level cost
and property level cost. For details, see "Billing Report Design Format – option and property level"
on the next page.

2. Customized CSA service designer for AmazonWeb Service Resource Provider is supported. For
details, see "Customized CSA Service Designer for AmazonWeb Service Resource Provider is
Supported" on the next page.
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Documentation

Billing Report Design Format – option and property level

The report displays the option and property cost for each selected user subscription. The period
granularity of this report is daily. The user can search by specific date range, by user name, by
organization name, or by subscription name.

Customized CSA Service Designer for Amazon Web Service Resource Provider is
Supported

In CSA, you can define different service designs for Amazon Provider and those service designs can
be different from user to user, and can be different from the CSA OOTB service design.

By default, the ETL logic hardcodes, the component type value, the component property value, and the
values match only the CSA OOTB service design. If you do not use the CSA OOTB service designer,
then youmust change the ETL scripts manually.
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In addition, when you add fields to component property list, and then display these field in the report,
the datamodel does not include the new customized data.

l The CSA Content Pack provides a separate ETL logic to support customized CSA service
designs

Below is the ETL logic that you can use to get the component value from the AWS service design.
To easily customize the logic in the ETL scripts:

a. The logic used to handle the AWS service design is extracted into a separate script instead of
having all logic in one Server Side Includes (SSI) step. The file name of the script is AWS-
service-design.

b. Afterwards, you canmodify the OOTB logic to support your ownCSA service design, without
impacting the others. Modify the $HPBA_
HOME/ContentPacks/CSA/INBUILT/ETL/COMPONENT/CSA_COMPONENT_CONF_
DF.sql file by providing the SSI scripts folder and the file name for the SSI component in the
CSTM_PROPERTY_<NN> fields.
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l Additional Customized Fields in the Component Entity to Support Customized CSA
Service Designs

Currently, you cannot add extra fields to theShowback for Cloud Services report as the current
datamodel cannot accommodate customized fields.

To support the capability of adding customized fields to theShowback for Cloud Services report,
the component was modified to include 10 additional customized fields. For details, see "CP0001
Enhancements and Their Documentation" on page 170.

l BILLING_FACT table details

To support option level pricing calculation, the existing BILLING_FACT table was modified. It
stores the real cost based on the subscription details including the subscription request, request
option, and option property. The granularity of BILLING_FACT table is at the levels of subscription,
request, option, property, daily.

Field Name Field Type Null Field Description

SUBSCRIPTION_ID FK N Foreign Key to subscription

SERVICE_
REQUEST_ID

FK N Foreign Key to subscription request

REQUEST_
OPTION_ID

FK N Foreign Key to request option

OPTION_
PROPERTY_ID

FK N Foreign Key to property

SERVICE_
INSTANCE_ID

FK N Foreign Key to service instance

BILLING_START DATE N Foreign Key to billing start period

BILLING_END DATE N Foreign Key to billing end period

CURRENCY_LOC VARCHAR
(10)

Y Source currency

CURRENCY_BASE VARCHAR
(10)

Y DWH currency

AMOUNT_LOC NUMERIC Y The cost stays with the source currency

AMOUNT_BASE NUMERIC Y The cost is converted into DWH currency

RECURRING_FLAG INTEGER Y The flag to identify if the cost is coming from
recurring price or not
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Field Name Field Type Null Field Description

1=Recurring price, 0=Initial price

BASE_FLAG INTEGER Y The flag to identify if the cost is coming from base
price or not

OPTION_FLAG INTEGER Y The flag to identify if the cost is coming from option
or not

PROPERTY_FLAG INTEGER Y The flag to identify if the cost is coming from
property price or not

l SERVICE_REQUEST_DIM table details

The user can subscribe to any on-shelf service offering in the CSA Consumer portal. When the user
subscribes to a service, CSA creates the relevant request for the subscription, and if the user
changes the subscription option from CPU 1 to CPU 2, another request is generated for the
modified subscription.

The SERVICE_REQUEST_DIM table holds the subscription request information for the business
analysis.

Field Name Field Type Null Field Description

SERVICE_
REQUEST_ID

PK N PK of service request

NAME VARCHAR
(1000)

Y Name of service request

DISPLAY_LABEL VARCHAR
(1000)

Y Display name of service request

INITIAL_PRICE NUMERIC Y Initial price of service request

RECURRING_
PRICE

NUMERIC Y Recurring price of service request

RECURRING_
PERIOD

VARCHAR
(100)

Y Recurring period of service request

CURRENCY VARCHAR
(10)

Y Source currency

REQUEST_
START

DATE Y The create time of service request

REQUEST_END DATE Y The time that the service request is end of lifecycle
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Field Name Field Type Null Field Description

REQUEST_
STATE

VARCHAR
(100)

Y The state of service request

REQUEST_
STATUS

VARCHAR
(100)

Y The status of service request

REQUEST_
ACTION

VARCHAR
(100)

Y The action of service request(mainly used to capture
the user subscription cancellation action)

SUBSCRIPTION_
ID

FK N Foreign Key to subscription

l REQUEST_OPTION_DIM table details

The user can subscribe to any on-shelf service offering in the CSA Consumer portal. When
subscribing to a service, the user can select the relevant option.

Below is the screenshot for CSA catalog ordering, Application ABC (1.0.0) is the subscription. It
contains three options Primary Storage, Backup Storage, andApplication Scaling. Each option
can define its own initial price and recurring price.

The REQUEST_OPTION_DIM table is designed to store the option level price information for each
user submitted service request.
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Field Name Field Type Null Field Description

REQUEST_OPTION_ID PK N PK of Request Option

OPTIONSET_NAME VARCHAR
(1000)

Y Name of Option Set

OPTIONSET_DISPLAY_
LABEL

VARCHAR
(1000)

Y Display name of Option Set

OPTION_NAME VARCHAR
(1000)

Y Name of Option

OPTION_DISPLAY_LABEL VARCHAR
(1000)

Y Display name of Option

OPTION_FULL_NAME VARCHAR
(2000)

Y Name of Option Set + Name of Option

OPTION_FULL_DISPLAY_
LABEL

VARCHAR
(2000)

Y Display name of Option Set + Display
name of Option

INITIAL_PRICE NUMERIC Y Initial price of option

RECURRING_PRICE NUMERIC Y Recurring price of option

RECURRING_PERIOD VARCHAR
(100)

Y Recurring period of option

SERVICE_REQUEST_ID FK N Foreign Key to Service request

PARENT_ID FK N Parent Foreign Key to Request Option

l REQUEST_OPTION_DIM_HIER table details

The user can subscribe any on-shelf service offering in the CSA Consumer portal. When
subscribing to a service, the user can select the relevant option. Each option can contain sub
options, which can themselves include sub options.

The REQUEST_OPTION_DIM_HIER table stores the option name hierarchy information for each
user submitted service request. Themaximum supported number of levels in the hierarchy is 20.

Field Name Field Type Null Field Description

MD_SLEVEL INTEGER N The level of the option

MD_LEVEL_0_NAME VARCHAR(2000) N The full name of top level option

MD_LEVEL_1_NAME VARCHAR(2000) Y The full name of second level option
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Field Name Field Type Null Field Description

MD_LEVEL_2_NAME VARCHAR(2000) Y The full name of third level option

…… VARCHAR(2000) Y The full name of n level option

MD_LEVEL_19_NAME VARCHAR(2000) Y The full name of twentieth level option

REQUEST_OPTION_ID FK N Foreign Key to Request option

For example, if you have the following hierarchy: option1 > option1.1> option1.1.1, then the row is
displayed as follows:

MD_
SLEVEL

MD_LEVEL_
0_NAME

MD_LEVEL_
1_NAME

MD_LEVEL_
2_NAME

MD_LEVEL_
3...19_NAME

REQUEST_
OPTION_ID

3 option1 option1.1 option1.1.1 Null option1.1.1's
PK

2 option1 option1.1 Null Null option1.1's PK

1 option1 Null Null Null option1's PK

l OPTION_PROPERTY_DIM table details

The user can subscribe any on-shelf service offering in the CSA Consumer portal. When
subscribing to a service, the user can select the relevant option. The option contains three
properties (250 GB, 500 GB, 800 GB), and each property can define its own initial price and
recurring price. The price supports fixed values, listed values, or multiple values.
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TheOPTION_PROPERTY_DIM table stores the property information for each user selected
property value in its related service request.

Field Name Field Type Null Field Description

OPTION_PROPERTY_ID PK N PK of Option property

PROPERTY_NAME VARCHAR
(1000)

Y The name of the property

PROPERTY_DISPLAY_
NAME

VARCHAR
(1000)

Y The display name of the property

PROPERTY_VALUE_ID VARCHAR
(1000)

Y The value ID of the option property

PROPERTY_VALUE_TYPE VARCHAR
(1000)

Y The value type of the property

PROPERTY_VALUE VARCHAR
(1000)

Y The value of the property

PROPERTY_DISPLAY_
VALUE

VARCHAR
(1000)

Y The display value of the property
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Field Name Field Type Null Field Description

INITIAL_PRICE NUMERIC Y The initial price of the property

INITIAL_PRICE_TYPE VARCHAR(100) Y The initial price type of the property

RECURRING_PRICE NUMERIC Y The recurring price of the property

RECURRING_PRICE_TYPE VARCHAR(100) Y The recurring price type of the
property

RECURRING_PERIOD VARCHAR(100) Y The recurring period of the property

REQUEST_OPTION_ID FK N Foreign Key to request option

l COMPONENT_DIM table enhancements

The existing COMPONENT_DIM table was extended by addingmore component properties to
support customized service designs.

Field Name Field Type Null Field Description

CSTM_PROPERTY_01 VARCHAR
(1000)

Y Customized component property
field

CSTM_PROPERTY_02 VARCHAR
(1000)

Y Customized component property
field

CSTM_PROPERTY_03 VARCHAR
(1000)

Y Customized component property
field

CSTM_PROPERTY_04 VARCHAR
(1000)

Y Customized component property
field

CSTM_PROPERTY_05 VARCHAR
(1000)

Y Customized component property
field

CSTM_PROPERTY_06 VARCHAR
(1000)

Y Customized component property
field

CSTM_PROPERTY_07 VARCHAR
(1000)

Y Customized component property
field

CSTM_PROPERTY_08 VARCHAR
(1000)

Y Customized component property
field

CSTM_PROPERTY_09 VARCHAR
(1000)

Y Customized component property
field

CSTM_PROPERTY_10 VARCHAR
(1000)

Y Customized component property
field
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Field Name Field Type Null Field Description

Other existing fields did not
change

l CSA Component_Property entity

Field Name Field Type Null Field Description

PROPERTY_NAME VARCHAR(1000) Y The name of the component property.

PROPERTY_VALUE VARCHAR(2000) N The value of the component property.

COMPONENT_ID FK Y Foreign Key to COMPONENT.

l CSA Target entity

Entity Name Change Description

BILLING_FACT Refactor the existing logic of the cost aggregation to store option
and property cost

REQUEST_OPTION_
DIM_HIER

New entity add to support option and sub option info

REQUEST_OPTION_DIM New entity add to support option info

OPTION_PROPERTY_
DIM

New entity add to support option property info

SERVICE_REQUEST_
DIM

New entity add to support service request info

COMPONENT_DIM Refactor the existing logic of the cost aggregation to store option
and property cost
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Online Documentation

To check for recent updates or to verify that you are using themost recent edition of a document, go to:

Support Site (https://softwaresupport.hp.com/group/softwaresupport/home)

Note: If you have reached this library, you have already signed in with your HPE Passport credentials.
You can also receive updated documentation if you subscribe to the appropriate product support
service. Contact your HPE sales representative for details. See Document Change Notes within the
document for a list of any revisions.

All Manuals Download

After downloading theAll Manuals Download zip file, unzip the full set on your local directory. You can
then search across the doc set using the Advanced Search capabilities in Adobe Acrobat.

Support

Visit the HP Software Support site at: https://softwaresupport.hpe.com.

This website provides contact information and details about the products, services, and support that
HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient
way to access interactive technical support tools needed tomanage your business. As a valued
support customer, you can benefit by using the support website to:

l Search for knowledge documents of interest
l Submit and track support cases and enhancement requests
l Download software patches
l Manage support contracts
l Look up HP support contacts
l Review information about available services
l Enter into discussions with other software customers
l Research and register for software training

Most of the support areas require that you register as an HP Passport user and to sign in. Many also
require a support contract. To register for an HP Passport ID, click Register on the HP Support site or
click Create an Account on the HP Passport logon page.

To findmore information about access levels, go to:
https://softwaresupport.hpe.com/web/softwaresupport/access-levels.

HPE IT Business Analytics (10.00)
Monday, March 28, 2016- 7:09:05 AM Page 181 of 182

https://softwaresupport.hp.com/group/softwaresupport/home
https://www.hpe.com/us/en/support.html
https://softwaresupport.hpe.com/
https://softwaresupport.hpe.com/web/softwaresupport/access-levels


HP Software Solutions Now accesses the HPSW Solution and Integration Portal website. This site
enables you to explore HP Product Solutions tomeet your business needs, includes a full list of
Integrations between HP Products, as well as a listing of ITIL Processes. The URL for this website is
http://h20230.www2.hp.com/sc/solutions/index.jsp.

Support Matrices

For complete support and compatibility information, see the support matrix for the relevant product
release. All support matrices and product manuals are available here on the HPE Software Support
Online website:

https://softwaresupport.hp.com/group/softwaresupport/support-matrices

You can also download the HPE Support and Compatibility Matrix for this release from the HPE Self-
solve documentation portal:

https://softwaresupport.hp.com/group/softwaresupport/

Document Change Notes

The following table provides details of any changes introduced in this version of this document.
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